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Question No: 1      ( Marks: 1 ) - Please choose one
A ---------- relies on the hardware manufacturer to assign a unique physical address to each network interface.

       ► Static addressing scheme
       ► Configurable addressing scheme

       ► Dynamic addressing scheme

      ► None of the given
Question No: 2      ( Marks: 1 ) - Please choose one
An interface for thin  Ethernet must have an ____________  connector , and must generate signals according to the_____________ specification.

       ► RJ-45, 10 Base T
       ► RJ-45, 10 Base 5

       ► BNC, 10 Base 2

       ► BNC, 10 Base T

Question No: 3      ( Marks: 1 ) - Please choose one
A system with redundant bridges might have a problem with_______ in the system.

       ► Loop
       ► Filters

       ► Spanning Trees

       ► All given choices

Question No: 4      ( Marks: 1 ) - Please choose one
A Bridge can ________

       ► Filter a frame

       ► Forward a frame

       ► Extend a LAN

       ► Do all the above
Question No: 5      ( Marks: 1 ) - Please choose one
________ is used for typical data applications (where the data rate may be unknown and bursty) and allows use of whatever bandwidth is available at a given time.

       ► Constant Bit Rate (CBR) service

       ► Variable Bit Rate (VBR) service

       ► Available Bit Rate (ABR) service
       ► None of the given

Question No: 6      ( Marks: 1 ) - Please choose one
ATM assigns each VC a _____________ identifier that is divided two parts to produce a hierarchy.

       ► 21-bit

       ► 22-bit

       ► 23-bit

       ► 24-bit
Question No: 7      ( Marks: 1 ) - Please choose one
________ of TCP/IP layering model, corresponds to basic network hardware.

       ► Physical Layer
       ► Network Interface Layer

       ► Internet Layer

       ► Transport Layer

Question No: 8      ( Marks: 1 ) - Please choose one
__________ places the boundary between the second and third octets

       ► Class A
       ► Class B

       ► Class C

       ► Class D

Question No: 9      ( Marks: 1 ) - Please choose one
UDP and TCP are both_________ layer protocols

       ► Physical

       ► Data link

       ► Network

       ► Transport
Question No: 10      ( Marks: 1 ) - Please choose one
Connection-oriented service, Point-to-point, Complete reliability, Full-duplex communication, Stream interface, Reliable connection startup and Graceful connection shutdown are the services provided by__________

       ► IP

       ► None of the given

       ► TCP
       ► UDP

Question No: 11      ( Marks: 1 ) - Please choose one
_______ protocols of TCP/IP layering model specify how to ensure reliable transfer.

       ► Physical Layer

       ► Network Interface Layer

       ► Internet Layer

       ► Transport Layer
Question No: 12      ( Marks: 1 ) - Please choose one
________identifies which application program on receiving computer should receive the data

  ► Logical address

Source port

Logical address

None of the give

 
       ► Source port

       ► Destination Port
       ► None of the given

Question No: 13      ( Marks: 1 ) - Please choose one
________ identifies the application program that sent the data.

       ►  Destination Port

       ► Source port
       ► Logical address

       ► None of the given

Question No: 14      ( Marks: 1 ) - Please choose one
Which of the following are interior routing protocols?

       ► RIP
       ► OSPF

       ► BGP

       ► RIP and OSPF

Question No: 15      ( Marks: 1 ) –www.vustudents.ning.com  Please choose one
The Border Gateway Protocol (BGP) uses_________ for all communication

       ► UDP

       ► TCP
       ► Both UDP and TCP

       ► None of the given

Question No: 16      ( Marks: 1 ) - Please choose one
__________measures distance in network hops, where each network between the source and destination counts as single hop.

       ► BGP

       ► OSPF

       ► RIP
       ► None of the given

Question No: 17      ( Marks: 1 ) - Please choose one
OSPF is based on--------

       ► Distance vector routing

       ► Link state routing
       ► Path vector routing

       ► Distance vector routing and Link state routing

Question No: 18      ( Marks: 1 ) - Please choose one
_________ performs local multicast and uses IP-in-IP encapsulation to send multicast datagrams from one site on the Internet to another.

      ► Distance Vector Multicast Routing Protocol (DVMRP)
       ► Core Based Trees (CBT)

       ► Protocol Independent Multicast_ Sparse Mode (PIM-SM)
       ► Protocol Independent Multicast _ Dense Mode (PIM-DM)
Question No: 19      ( Marks: 1 ) - Please choose one
The length of time required to send a variable length packet is variable and does not require a complicated interrupt scheme to detect completion of transmission.

       ► True

       ► False
Question No: 20      ( Marks: 1 ) - Please choose one
NEXT HEADER field in the base header defines type of header and it appears at end of fixed-size base header.

       ► True
       ► False

Question No: 21      ( Marks: 1 ) - Please choose one
Although message exchange can be used to bind addresses, sending a request for each binding is hopelessly inefficient.

       ► True
       ► False

Question No: 22      ( Marks: 1 ) - Please choose one
Address mask defines how many bits of address are in suffix?

       ► True

       ► False
Question No: 23      ( Marks: 1 ) - Please choose one
A computer attached to a given network can only communicate with other computers attached to the same network. Is this a problem with multiple networks?

       ► True
       ► False

Question No: 24      ( Marks: 1 ) - Please choose one
In the 1970s large organizations began to acquire multiple networks. Each network in the organization formed island. Employees needed to choose a computer appropriate for each task. So they needed multiple screens, keyboards and computers.

       ► False

       ► True
Question No: 25      ( Marks: 1 ) - Please choose one
The term self-identifying is used for Classful IP addresses because the class of the address can be computed from the address__________.          

       ► itself
       ► prefix

       ► suffix

       ► mask

Question No: 26      ( Marks: 1 ) - Please choose one
In which method of Address Resolution Protocol the protocol address independent of hardware address?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
       ► T, C

       ► D

       ► C

       ► T, D
Question No: 27      ( Marks: 1 ) - Please choose one
In which method of Address Resolution Protocol the protocol address is determined by hardware address?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
       ► T

       ► D

       ► C
       ► T, C

Question No: 28      ( Marks: 1 ) - Please choose one
Reconstruction of original datagram is called reassembly.

       ► True
       ► False

Question No: 29      ( Marks: 1 ) - Please choose one
A computer needs a complete stack of protocols to run either a client or a server.

       ► True
       ► False

Question No: 30      ( Marks: 1 ) - Please choose one
TCP uses _______ mechanism to control the flow of data.

       ► door

       ► window
       ► acknowledgment

       ► retransmission
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Question No: 1      ( Marks: 1 ) - Please choose one
Computer networks are often called -------------- because they use packet technology.

       ► Ethernet

       ► Switch networks

       ► Packet networks

        ► None of the given
 Question No: 2      ( Marks: 1 ) - Please choose one
A network uses a ------arranges for computers to be connected in a closed loop.

       ► Star Topology

       ► Ring Topology
        ► Bus Topology

        ► None of the given

 In a ring topology each computer is connected to other thorough a ring

Question No: 3      ( Marks: 1 ) - Please choose one
An ------------method, the network hardware designers specify how type information is included in the frame and the value use to identify various frame types.

       ► Explicit frame type
        ► Ideal frame type

        ► Implicit frame type

        ► None of the given

EXPLICIT FRAME TYPE:

In this type the identifying value is included with frame describes types of

included data.

Question No: 4      ( Marks: 1 ) - Please choose one
An interface for thin Ethernet must have an ____________ connector , and must generate signals according to the_____________ specification.

       ► RJ-45, 10 Base T (reference not available)
        ► RJ-45, 10 Base 5

        ► BNC, 10 Base 2

        ► BNC, 10 Base T

Question No: 5      ( Marks: 1 ) - Please choose one
A Bridge forwards or filters a frame by comparing the information in its address table to the frame’s__________

       ► Layer 2 source address

        ► Source node’s physical address

        ► Layer 2 destination address     (not confirm)
       ► Layer 3 destination address

 Question No: 6      ( Marks: 1 ) - Please choose one
Most WAN systems include a mechanism that can be used to eliminate the common case of duplication routing is called___________

        ► Hierarchal address

        ► Default route
        ► Shortest path

       ► None of the given

Most WAN systems include a mechanism that can be used to eliminate the common case of duplication routing is called Default route. The mechanism allows a single entry in a forwarding table to replace a long list of entries that have the same next hope value

Question No: 7      ( Marks: 1 ) - Please choose one
________ of TCP/IP layering model, corresponds to basic network hardware.

       ► Physical Layer
       ► Network Interface Layer

        ► Internet Layer

      ► Transport Layer

LAYER 1:

Corresponds to basic network hardware layer in OSI

Question No: 9      ( Marks: 1 ) - Please choose one
________is called an end-to-end protocol because it provide a connection directly from an application on one computer to an application on a remote computer.

       ► IP

       ► UDP
        ► TCP

        ► None of the given

UDP has the following characteristics.

It is an end-to-end protocol. It provides application-to-application communication.

Question No: 10      ( Marks: 1 ) - Please choose one
____________ uses distance vector approach to define routing

       ► BGP

      ► OSPF

        ► RIP
        ► None of the given

 DISTANCE-VECTOR ROUTING:
• It is very simple to implement.

• Packet switch updates its own routing table first.

• It is used in RIP.

Question No: 11      ( Marks: 1 ) - Please choose one
_______    is ideal in a situation where the group is small and all members are attached to contiguous Local Area Networks.

       ► Flood-and -Prune
        ► Configuration-and -Tunneling

       ► Core-Based Discovery

       ► None of the give006E
FLOOD-AND-PRUNE:
Flood-and-prune is ideal in a situation where the group is small and all members

Are attached to contiguous Local Area Networks.

Question No: 12      ( Marks: 1 ) - Please choose one
Router that decrements TTL to __ sends ICMP time exceeded message, with router’s address as source address

       ► 3

       ► 2

       ► 1

       ► 0
Router that decrements TTL to 0 sends ICMP time exceeded message, with router’s

address as source address

Question No: 13      ( Marks: 1 ) - Please choose one
Protocol addresses are abstractions provided by ___________.

       ► hardware

       ► software
       ► operating system

       ► internet

PROTOCOL ADDRESSES AND PACKET DELIVERY:

Protocol addresses are abstractions provided by software

Question No: 14      ( Marks: 1 ) - Please choose one
Although message exchange can be used to bind addresses, sending a request for each binding is hopelessly inefficient.

       ► True
       ► False

 CASHING ARP RESPONSES:

Although message exchange can be used to bind addresses, sending a request for

each binding is hopelessly inefficient
 Question No: 15      ( Marks: 1 ) - Please choose one
ARP is almost always used to bind a ___-bit IP address to a ___-bit Ethernet address.

       ► 32, 48
       ► 24, 32

       ► 32, 64

       ► 32, 128

 ARP is almost always used to bind a 32-bit IP address to a 48-bit Ethernet address

Question No: 16      ( Marks: 1 ) - Please choose one
In the 1970s large organizations began to acquire multiple networks. Each network in the organization formed island. Employees needed to choose a computer appropriate for each task. So they needed multiple screens, keyboards and computers.

        ► False

        ► True
In the 1970s large organizations began to acquire multiple networks. Each
network in the organization formed island. Employees needed to choose a
computer appropriate for each task. So they needed multiple screens, keyboards
and computers.
Question No: 17      ( Marks: 1 ) www.vustudents.ning.com  - Please choose one
In which method of Address Resolution Protocol the protocol address is determined by hardware address?
Were "T" stands for Table lookup, "C" for Closed-form 
·    Header contains all information needed to deliver datagram to the destination
computer. It contains:
• Destination address
• Source address
• Identifier
• Other delivery information 
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 Question No: 1      ( Marks: 1 ) - Please choose one
 The number of connections needed for N computer in direct point to point communication is equal to:

        ► (N2 –N)/2
        ► N(N- 1)

       ► N2
        ► None of the given

For ‘n’ computers connections in direct point to point communication = (n^2 –n)/2.
                           
Question No: 2      ( Marks: 1 ) - Please choose one
When an application--------------- data, it makes a copy of the data available to all other computers on the network.

       ► Broadcasting

        ► Multicasting

        ► Unicasting

        ► None of the given (not sure)
 Question No: 3      ( Marks: 1 ) - Please choose one
Ethernet uses a ------ bit static addressing scheme in which each device is assigned a unique address by the manufacturer.

       ► 64

        ► 48
        ► 32

        ► 8

Ethernet uses a 48-bit static addressing scheme
 Question No: 4      ( Marks: 1 ) - Please choose one
 A system with redundant bridges might have a problem with_______ in the system.

        ► Loop
        ► Filters

        ► Spanning Trees

        ► All given choices

 Reference not available
Question No: 5      ( Marks: 1 ) - Please choose one
The product of delay and throughput measures the _____ of data that can be present on the network.

        ► Area

        ► Volume
        ► Length

        ► None of the given

It is computed as delay time multiplied by effective throughput. It measures amount of data that can be present in the network
Question No: 6      ( Marks: 1 ) - Please choose one
Connectionless service, Message-Oriented protocol, best effort delivery service, arbitrary interaction and operating system independent are the characteristics of _____________

        ► TCP

        ► UDP
        ► IP

        ► None of the given

 UDP has the following characteristics.
• It is an end-to-end protocol. It provides application-to-application communication.
• It provides connectionless service.
• It is a Message-Oriented protocol.
• It uses best-effort delivery service.
• It follows arbitrary interaction.
• It is operating system independent
 Question No: 7      ( Marks: 1 ) - Please choose one
 Connection-oriented service, Point-to-point, Complete reliability, Full-duplex communication, Stream interface, Reliable connection startup and Graceful connection shutdown are the services provided by__________

        ► None of the given

        ► TCP
        ► UDP

        ► IP

SERVICE PROVIDED BY TCP:
Following are the services provided by TCP:
• Connection-oriented service
• Point-to-point
• Complete reliability
• Full-duplex communication
• Stream interface
• Reliable connection startup
• Graceful connection shutdown
Question No: 8      ( Marks: 1 ) - Please choose one
The process of using a routing table to select a next hop for a given datagram is called_________

        ► Encapsulation

        ► Reassembling

        ► Routing or forwarding 
        ► None of the given

Reference not available
 Question No: 9      ( Marks: 1 ) www.vustudents.ning.com  - Please choose one
____________ uses distance vector approach to define routing

        ► BGP

        ► OSPF

        ► RIP
        ► None of the given

DISTANCE-VECTOR ROUTING:
• It is very simple to implement.
• Packet switch updates its own routing table first.
• It is used in RIP.

Question No: 10      ( Marks: 1 ) - Please choose one
A multicast routing scheme in which the protocol software builds a delivery tree from a central point is called__________

       ► Distance Vector Multicast Routing Protocol (DVMRP)

        ► Core Based Trees (CBT)
        ► Protocol Independent Multicast_ Sparse Mode (PIM-SM)
        ► Protocol Independent Multicast _ Dense Mode (PIM-DM)
 CORE BASED TREES (CBT):
A multicast routing scheme in which the protocol software builds a delivery tree
from a central point.
 Question No: 11      ( Marks: 1 ) - Please choose one
 One repeater _______, two repeaters ________ the maximum cable length limitation.

       ► doubles, cancel

        ► doubles, triple
        ► square roots, cude roots

        ► and, triple

 One repeater doubles, two repeaters triple the maximum cable length limitation.
Question No: 12      ( Marks: 1 ) - Please choose one
Whenever it handles a packet, IP software needs to separate the destination address into a _________ and ___________.

        ► postfix, Infix

        ► non of these

        ► Infix, prefix

        ► prefix, suffix
 Whenever it handles a packet, IP software needs to separate the destination address into a prefix and suffix
Question No: 13      ( Marks: 1 ) - Please choose one
 Although message exchange can be used to bind addresses, sending a request for each binding is hopelessly inefficient.

        ► True
        ► False

CASHING ARP RESPONSES:
Although message exchange can be used to bind addresses, sending a request for
each binding is hopelessly inefficient.
Question No: 14      ( Marks: 1 ) - Please choose one
 ARP is almost always used to bind a ___-bit IP address to a ___-bit Ethernet address.

        ► 32, 48
        ► 24, 32

        ► 32, 64

        ► 32, 128

ARP is almost always used to bind a 32-bit IP address
to a 48-bit Ethernet address
 Question No: 15      ( Marks: 1 ) - Please choose one
 End-to-end delivery service is connection oriented.

        ► True

        ► False       
End-to-end delivery service is connection less
Question No: 16      ( Marks: 1 ) - Please choose one
 A single networking technology is best for all needs.

 
       ► True

 
       ► False

There is no single networking technology that is best for all needs
Question No: 17      ( Marks: 1 ) - Please choose one
In the 1970s large organizations began to acquire multiple networks. Each network in the organization formed island. Employees needed to choose a computer appropriate for each task. So they needed multiple screens, keyboards and computers.

       ► False

       ► True
In the 1970s large organizations began to acquire multiple networks. Each network in the organization formed island. Employees needed to choose a computer appropriate for each task. So they needed multiple screens, keyboards and computers.

Question No: 18      ( Marks: 1 ) - Please choose one
Which method of Address Resolution Protocol is useful with any hardware?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
	Features
 
	Types of
Resolution

	Use full with any hardware
	T

	Address change affects all hosts
	T

	Protocol address is determined by hardware address
	C


       ► T
        ► C

        ► D

        ► C, D

 
 
 
Question No: 19      ( Marks: 1 ) - Please choose one
In which method of Address Resolution Protocol the protocol address is determined by hardware address?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
	Features
 
	Types of
Resolution

	Use full with any hardware
	T

	Address change affects all hosts
	T

	Protocol address is determined by hardware address
	C


        ► T

        ► D

        ► C
        ► T, C

 
 
 
Question No: 20      ( Marks: 1 ) - Please choose one
We use the term _______ to refer to a measure of the path that routing software use when choosing a route.

        ► routing path

        ► routing metric
        ► routing

         switching
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Question No: 1 ( Marks: 1 ) - Please choose one
In Direct point to point communication adding the Nth computer requires------------ new connections.
► None of the given
► N2
► N-1
► (N2 –N)/2
disadvantage In Direct point to point communication is that adding a new computer to the network requires N-1 new connections .(P# 23)
Question No: 2 ( Marks: 1 ) - Please choose one
In Point-to-Point topology there are two topologies.

► Tree and Ring
► Star and Ring
► Star and Tree
► None of the given
POINT-TO-POINT:
In Point-to-Point topology there are two topologies.

1) STAR topology

2) TREE topology
Question No: 3 ( Marks: 1 ) - Please choose one
In -------------, network occupies the smaller area like a room a floor or a building
► LAN
► WAN 
► MAN
► None of the given
In LAN network occupies the smaller area like a room a floor or a building.(P# 4)

It identifies an individual computer on the network.
Question No: 15 ( Marks: 1 ) - Please choose one
___________ places the boundary between the first and second octets
► Class A
► Class B
► Class C
► Class D
Class A places the boundary between the first and second octets. Class B places the boundary between the second and third octets, and class C places the boundary between the third and fourth octets.

Question No: 16 ( Marks: 1 ) - Please choose one
___________ places the boundary between the third and fourth octets.
► Class A
► Class B
► Class C
► Class D
Class A places the boundary between the first and second octets. Class B places the boundary between the second and third octets, and class C places the boundary between the third and fourth octets.
Question No: 17 ( Marks: 1 ) - Please choose one
________ field of header indicates whether a datagram is a fragment or a complete datagram.
► FLAGS
► FLAGMENT OFFSET
► IDENTIFICATION
► None of the given
FRAGMENTATION:
IP uses fragmentation i.e. datagrams can be split into pieces to fit in network with small MTU. Each fragment is an independent datagram. It includes all header fields. Bit in header indicates that the datagram is a fragment
Question No: 18 ( Marks: 1 ) - Please choose one
______ provides connectionless service.
► TCP
► UDP
► IP
► None of the given
UDP has the following characteristics.
• It is an end-to-end protocol. It provides application-to-application communication.

• It provides connectionless service.

• It is a Message-Oriented protocol.

• It uses best-effort delivery service.

• It follows arbitrary interaction.

• It is operating system independent
Question No: 19 ( Marks: 1 ) - Please choose one
UDP and TCP are both_________ layer protocols
► Physical
► Data link
► Network
► Transport
Question No: 20 ( Marks: 1 ) - Please choose one
Connection-oriented service, Point-to-point, Complete reliability, Full-duplex communication, Stream interface, Reliable connection startup and Graceful connection shutdown are the services provided by__________
► IP
► None of the given
► TCP
► UDP
SERVICE PROVIDED BY TCP:
Following are the services provided by TCP:

• Connection-oriented service

• Point-to-point

• Complete reliability

• Full-duplex communication

• Stream interface

• Reliable connection startup

• Graceful connection shutdown
Question No: 21 ( Marks: 1 ) - Please choose one
_______ protocols of TCP/IP layering model specify how to ensure reliable transfer.
► Physical Layer
►Network Interface Layer 
► Internet Layer
► Transport Layer
LAYER 4: ensure reliable transfer layer 4 in TCP layering model is transport layer
Question No: 22 ( Marks: 1 ) - Please choose one
________identifies which application program on receiving computer should receive the data
► Logical address
► Source port
► Destination Port
► None of the given
FieldDestinationPort identifies which application program on receiving computer should receive the data. While field source port identifies the application programs that sent the data. (reference from E-books)
Question No: 23 ( Marks: 1 ) - Please choose one
________ identifies the application program that sent the data. 
► DestinationPort
► Source port
► Logical address
► None of the given
FieldDestinationPort identifies which application program on receiving computer should receive the data. While field source port identifies the application programs that sent the data. (reference from E-books)
Question No: 24 ( Marks: 1 ) - Please choose one
The Border Gateway Protocol (BGP) uses_________ for all communication
► UDP
► TCP
► Both UDP and TCP
► None of the given
 BORDER GATEWAY PROTOCOL:
It is most popular Exterior Gateway Protocol in Internet. It has following characteristics:

"It provides routing among autonomous systems (EGP).

"It provides policies to control routes advertised.

"It uses reliable transport (TCP).
Question No: 25 ( Marks: 1 ) - Please choose one
Which of the following protocols allows the sender and receiver to enforce polices.
► RIP
► OSPF
► BGP
► RIP and OSPF
Question No: 26 ( Marks: 1 ) - Please choose one
____________ uses distance vector approach to define routing
► BGP
► OSPF
► RIP
► None of the given
ROUTING INFORMATION PROTOCOL (RIP):
It has the following characteristics:

"It is used for routing within an autonomous system (IGP).
"Hop Count Metric: RIP measures distance in network hops, where each network

between the source and destination counts as a single hop.

"It uses UDP for all message transmissions.

"RIP is used over LAN. Version 1 of RIP uses hardware broadcast and version 2 allows

delivery via multicast.

"It can be used to advertise default route propagation. An organization can use RIP to

install a default route in each router.

"It uses distance vector algorithm.
Question No: 27 ( Marks: 1 ) - Please choose one
ICMP message transport is acted upon by getting ICMP encrypted in IP.
► True
► False
ICMP message transport is acted upon by getting ICMP encapsulated in IP (P# 117)
Question No: 28 ( Marks: 1 ) - Please choose one
Protocol addresses are abstractions provided by ___________. 
► hardware
► software
► operating system
► internet
Protocol addresses are abstractions provided by software
Question No: 29 ( Marks: 1 ) - Please choose one
These packets serve same purpose on ________ as frames on ______
► Intranet, LAN
► Internet, WAN
► Intranet, WAN
► Internet, LAN
VIRTUAL PACKETS:
These packets serve same purpose in Internet as frames on LAN
Question No: 30 ( Marks: 1 ) - Please choose one
Address mask defines how many bits of address are in suffix?
► True
► False
Address mask defines how many bits of address are in prefix. Prefix defines how much of address used to identify network.
Question No: 31 ( Marks: 1 ) - Please choose one
A single networking technology is best for all needs.
► True
► False
There is no single networking technology that is best for all needs
Question No: 32 ( Marks: 1 ) - Please choose one
A computer attached to a given network can only communicate with other computers attached to the same network. Is this a problem with multiple networks?

► True
► False
The chief problems with multiple networks are as follows:

• A computer attached to a given network can only communicate with other

computers attached to the same network.
Question No: 33 ( Marks: 1 ) - Please choose one
The term self-identifying is used for Classful IP addresses because the class of the address can be computed from the address__________. 
► itself
► prefix
► suffix
► mask
Classful IP addresses are self-identifying because the class of the address can be computed from the address itself
Question No: 34 ( Marks: 1 ) - Please choose one
Find the class of the address.
10100111 11011011 10001011 01101111
► A
► B
► E
► C
Reference table handouts P # 87
Question No: 35 ( Marks: 1 ) - Please choose one
Find the class of the address:
11110011 10011011 11111011 00001111 
► A
► C
► E
► B
Reference table handouts P # 87
Question No: 36 ( Marks: 1 ) - Please choose one
In which method of Address Resolution Protocol the protocol address is determined by hardware address? www.vustudents.ning.com  
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
► T
► D
► C
► T, C
 Reference table handouts P # 97
Question No: 37 ( Marks: 1 ) - Please choose one
Which method of Address Resolution Protocol requires hardware broadcast?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
► D
► T
► C
► T, D
Reference table handouts P # 97
Question No: 38 ( Marks: 1 ) - Please choose one
Which method of Address Resolution Protocol resolution with minimum delay?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
► T, D
► c
► T
► T, C
Reference table handouts P # 97
Question No: 39 ( Marks: 1 ) - Please choose one
In which method of Address Resolution Protocol the implimentation is more difficult?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
► T, C
► T
► C
► D
Reference table handouts P # 97
Question No: 40 ( Marks: 1 ) - Please choose one
On of the design goals for unicast route propagation is __________.
► Consistency
► inconsistency
► stability
► dynamic addressing
On of the design goals for unicast route propagation is stability—continual changes in route are undesirable because they lead to higher jitter and datagram arriving out of order. Thus, once a unicast routing protocol finds a shortest path, it usually retains the route until a failure makes the path unusable. (Reference from E-book)
Question No: 41 ( Marks: 1 ) - Please choose one
Propagation multicast routing information differs dramatically from unicast route propagation?
► True
► False
Propagating multicast routing information differs dramatically from unicast route propagation. The difference arises because internet multicast allows dynamic group membership and autonomous senders
Question No: 42 ( Marks: 1 ) - Please choose one
The IP multicast abstraction allows an application running on an arbitrary computer to leave a multicast group at any time. While _____________ application on a computer remain a member of a group.
► One or more
► only one
► no
► many
Question No: 43 ( Marks: 1 ) - Please choose one
To save traffic, an EGP does not summerize routing information from the autonomous system before passing it to another autonomous system.
► True
► False
To save traffic, an EGP summerize routing information from the autonomous system before passing it to another autonomous system. More important an EGP implements policy constraints that allow a system manager to determine exactly what information is released outside the organization. (Reference from E-book)
Question No: 44 ( Marks: 1 ) - Please choose one
In IPv6 the type of address used for collection of computers with same prefix. Are known as_________.
► Anycast
► Unicast
► Multicast
► Non of the given
Following are special types of addresses, IPv6 uses:

Unicast: It is used for single destination computer.

Multicast: It is used for multiple destinations; possibly not at same site.

Cluster: This type of address is used for collection of computers with same prefix,

datagram is delivered to one out of cluster.
Question No: 45 ( Marks: 1 ) - Please choose one
Special types of addresses in IPv6 used for multiple destinations; possibly not at same site. Are known as_________.
► Unicast
► Anycast
► Multicast
► Non of the given
Following are special types of addresses, IPv6 uses:
Unicast: It is used for single destination computer.

Multicast: It is used for multiple destinations; possibly not at same site.

Cluster: This type of address is used for collection of computers with same prefix,

datagram is delivered to one out of cluster.
Question No: 46 ( Marks: 1 ) - Please choose one
UDP offers application programs a Message-Oriented Interface, applications can depend on protocol to preserve data boundaries.
► True
► False
UDP offers application programs a Message-Oriented Interface. It does not divide messages into packets for transmission and does not combine messages for delivery.

ADVANTAGES:

• Applications can depend on protocol to preserve data boundaries.
Question No: 47 ( Marks: 1 ) - Please choose one
Reliability is the responsibility of the _________ layer
► Network
► Datalink
► Transport
► Application
Reliability is the responsibility of the Transport layer
Question No: 48 ( Marks: 1 ) - Please choose one
TCP uses _______ mechanism to control the flow of data.
► door
► window
► acknowledgment
► retransmission
TCP uses window mechanism to control the flow of data.
Question No: 49 ( Marks: 1 ) - Please choose one
The time for acknowledgement to arrival of packet depends on.
► Distance to destination and Current traffic conditions
► Current traffic conditions
► Distance to destination
► non of these
The time for acknowledgement to arrive depends on:

• Distance to destination

• Current traffic conditions
Question No: 50 ( Marks: 1 ) - Please choose one
FDDI can transmits data at a rate of ----------
► 100 million bits per second
► 10 million bits per second
► 1000 million bits per second
► None of the given
FDDI: Fiber distributed data interconnect (FDDI) is another ring technology. Its most

important features are:
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some mcqs given below

1) When an application--------------- data, it makes a copy of the data available to all other computers on the network.

       ► Broadcasting
        ► Multicasting

        ► Unicasting

       ► None of the given

2) Ethernet uses a ------ bit static addressing scheme in which each device is assigned a unique address by the manufacturer.

       ► 64

        ► 48
        ► 32

        ► 8

3) The product of delay and throughput measures the _____ of data that can be present on the network.

      ► Area

        ► Volume (supposition)
        ► Length

        ► None of the given

  4) Connectionless service, Message-Oriented protocol, best effort delivery service, arbitrary interaction and operating system independent are the characteristics of _____________

        ► TCP

        ► UDP
        ► IP

        ► None of the given

  5) ____________ uses distance vector approach to define routing

        ► BGP

        ► OSPF

        ► RIP
        ► None of the given

6) Whenever it handles a packet, IP software needs to separate the destination address into a _________ and ___________.

        ► postfix, Infix

        ► non of these

        ► Infix, prefix

        ► prefix, suffix
7) ARP is almost always used to bind a ___-bit IP address to a ___-bit Ethernet address.

       ► 32, 48
        ► 24, 32

        ► 32, 64

        ► 32, 128

8) Which method of Address Resolution Protocol is useful with any hardware?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
       ► T

        ► C (Supposition)
        ► D

        ► C, D

9) In which method of Address Resolution Protocol the protocol address is determined by hardware address?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
       ► T

        ► D

        ► C
        ► T, C

10 )We use the term _______ to refer to a measure of the path that routing software use when choosing a route.

        ► routing path

        ► routing metric
        ► routing

        ► switching

11) A network uses a ------arranges for computers to be connected in a closed loop.

        ► Star Topology

       ► Ring Topology
       ► Bus Topology

       ► None of the given

12) An interface for thin  Ethernet must have an ____________  connector , and must generate signals according to the_____________ specification.

       ► RJ-45, 10 Base T
        ► RJ-45, 10 Base 5

        ► BNC, 10 Base 2

       ► BNC, 10 Base T

13) _______ protocols of TCP/IP layering model specify how to ensure reliable transfer.

       ► Physical Layer

      ► Network Interface Layer

       ► Internet Layer

       ► Transport Layer
14)____________ uses distance vector approach to define routing

        ► BGP

       ► OSPF

       ► RIP
       ► None of the given
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Question No: 1 ( Marks: 1 ) – Please choose one

Computer networks are often called ————– because they usepacket technology.

► Ethernet
► Switch networks
► Packet networks
► None of the given
Question No: 2 ( Marks: 1 ) – Please choose one

A network uses a ——arranges for computers to be connected in a closed loop.

► Star Topology
► Ring Topology
► Bus Topology
► None of the given
In a ring topology each computer is connected to other thorough a ring

Question No: 3 ( Marks: 1 ) – Please choose one

An ————method, the network hardware designers specify how type information is included in the frame and the value use to identify variousframe types.

► Explicit frame type
► Ideal frame type
► Implicit frame type
► None of the given
EXPLICIT FRAME TYPE:

In this type the identifying value is included with frame describes types of

included data.

Question No: 4 ( Marks: 1 ) – Please choose one

An interface for thin Ethernet must have an ____________ connector , and must generate signals according to the_____________ specification.

► RJ-45, 10 Base T
► RJ-45, 10 Base 5
► BNC, 10 Base 2
► BNC, 10 Base T
Question No: 5 ( Marks: 1 ) – Please choose one

A Bridge forwards or filters a frame by comparing the information in its address table to the frame’s_________

► Layer 2 source address
► Source node’s physical address
► Layer 2 destination address
► Layer 3 destination address
Question No: 6 ( Marks: 1 ) – Please choose one

Most WAN systems include a mechanism that can be used to eliminate the common case of duplication routing is called___________

► Hierarchal address
► Default route
► Shortest path
► None of the given
Question No: 7 ( Marks: 1 ) – Please choose one

________ of TCP/IP layering model, corresponds to basic network hardware.

► Physical Layer
► Network Interface Layer
► Internet Layer
► Transport Layer
LAYER 1:

Corresponds to basic network hardware layer in OSI

Question No: 8 ( Marks: 1 ) – Please choose one

_______ protocols of TCP/IP layering model specify how to ensure reliable transfer.

► Physical Layer
► Network Interface Layer
► Internet Layer
► Transport Layer
Fourth layer which is transport layer will take care of reliable transfer
Question No: 9 ( Marks: 1 ) – Please choose one

________is called an end-to-end protocol because it provide a connection directly from an application on one computer to an application on a remote computer.

► IP
► UDP
► TCP
► None of the given
UDP has the following characteristics.

It is an end-to-end protocol. It provides application-to-application communication.

http://vuzs.net/
Question No: 10 ( Marks: 1 ) – Please choose one http://www.vuzs.net/

____________ uses distance vector approach to define routing

► BGP
► OSPF
► RIP
► None of the given
DISTANCE-VECTOR ROUTING:

• It is very simple to implement.

• Packet switch updates its own routing table first.

• It is used in RIP

Question No: 11 ( Marks: 1 ) – Please choose one

_______ is ideal in a situation where the group is small and all members are attached to contiguous Local Area Networks.

► Flood-and -Prune
► Configuration-and -Tunneling
► Core-Based Discovery
► None of the given
FLOOD-AND-PRUNE:

Flood-and-prune is ideal in a situation where the group is small and all members

are attached to contiguous Local Area Networks.
Question No: 12 ( Marks: 1 ) – Please choose one

Router that decrements TTL to __ sends ICMP time exceeded message, with router’s address as source address

► 3
► 2
► 1
► 0
outer that decrements TTL to 0 sends ICMP time exceeded message, with router’s

address as source address

Question No: 13 ( Marks: 1 ) – Please choose one

Protocol addresses are abstractions provided by ___________. http://www.vuzs.net/

► hardware
► software
► operating system
► internet
PROTOCOL ADDRESSES AND PACKET DELIVERY:

Protocol addresses are abstractions provided by software

Question No: 14 ( Marks: 1 ) – Please choose one

Although message exchange can be used to bind addresses, sending a request for each binding is hopelessly inefficient.

► True
► False
CASHING ARP RESPONSES:

Although message exchange can be used to bind addresses, sending a request for

each binding is hopelessly inefficient

Question No: 15 ( Marks: 1 ) – Please choose one

ARP is almost always used to bind a ___-bit IP address to a ___-bit Ethernet address.

► 32, 48
► 24, 32
► 32, 64
► 32, 128
ARP is almost always used to bind a 32-bit IP address to a 48-bit Ethernet address

Question No: 16 ( Marks: 1 ) – Please choose one

In the 1970s large organizations began to acquire multiple networks. Each network in the organization formed island. Employees needed to choose a computer appropriate for each task. So they needed multiple screens, keyboards and computers.

► False
► True


Question No: 17 ( Marks: 1 ) – Please choose one

In which method of Address Resolution Protocol the protocol address is determined by hardware address?

Were “T” stands for Table lookup, “C” for Closed-form Computation and “D” for Data Exchange?

	Features
	Types of

Resolution

	Use full with any hardware
	T

	Address change affects all hosts
	T

	Protocol address is determined by hardware address
	C


► T
► D
► C
► T, C
Question No: 18 ( Marks: 1 ) – Please choose one

The general form of an IP datagram is with a header followed by data. The header contains information that controls where and how the datagram is to be sent.

► True
► False
Header contains all information needed to deliver datagram to the destination

computer. It contains:

• Destination address

• Source address

• Identifier

• Other delivery information

Question No: 19 ( Marks: 1 ) – Please choose one

To save traffic, an EGP does not summarize routing information from the autonomous system before passing it to another autonomous system.

► True
► False
Question No: 20 ( Marks: 1 ) – Please choose one

Which of the following is a correct representation of the IPv6?

► 105.220.136.100.255.255.255.255.0.0.18.128.140.10.255.255
► 105.220.136.100.255.255.255.256.0.0.18.128.140.10.255.255

► 105.220.136.100.255.255.255.255.0.0.18.128.140.10.255.255.256

A ---------- relies on the hardware manufacturer to assign a unique physical address to each network interface.

       ► Static addressing scheme
       ► Configurable addressing scheme

       ► Dynamic addressing scheme
       ► None of the given
Question No: 2      ( Marks: 1 ) - Please choose one

[image: image4.wmf] 

 
An interface for thin  Ethernet must have an ____________  connector , and must generate signals according to the_____________ specification.
       ► RJ-45, 10 Base T
       ► RJ-45, 10 Base 5

       ► BNC, 10 Base 2

       ► BNC, 10 Base T
Question No: 3      ( Marks: 1 ) - Please choose one

[image: image5.wmf] 

 
A system with redundant bridges might have a problem with_______ in the system.

       ► Loop

       ► Filters
       ► Spanning Trees
       ► All given choices
Question No: 4      ( Marks: 1 ) - Please choose one

[image: image6.wmf] 

 
A Bridge can ________

       ► Filter a frame

       ► Forward a frame
       ► Extend a LAN
       ► Do all the above
Question No: 5      ( Marks: 1 ) - Please choose one

[image: image7.wmf] 

 
________ is used for typical data applications (where the data rate may be unknown and bursty) and allows use of whatever bandwidth is available at a given time.
       ► Constant Bit Rate (CBR) service
       ► Variable Bit Rate (VBR) service
       ► Available Bit Rate (ABR) service
       ► None of the given
Question No: 6      ( Marks: 1 ) - Please choose one

[image: image8.wmf] 

 
ATM assigns each VC a _____________ identifier that is divided two parts to produce a hierarchy.
       ► 21-bit
       ► 22-bit
       ► 23-bit
       ► 24-bit
Question No: 7      ( Marks: 1 ) - Please choose one

[image: image9.wmf] 

 
________ of TCP/IP layering model, corresponds to basic network hardware.

       ► Physical Layer

       ► Network Interface Layer 
       ► Internet Layer
       ► Transport Layer
Question No: 8      ( Marks: 1 ) - Please choose one

[image: image10.wmf] 

 
___________ places the boundary between the second and third octets
       ► Class A
       ► Class B
       ► Class C
       ► Class D
Question No: 9      ( Marks: 1 ) - Please choose one
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UDP and TCP are both_________ layer protocols

       ► Physical
       ► Data link
       ► Network
       ► Transport
Question No: 10      ( Marks: 1 ) - Please choose one

[image: image12.wmf] 

 
Connection-oriented service, Point-to-point, Complete reliability, Full-duplex communication, Stream interface, Reliable connection startup and Graceful connection shutdown are the services provided by__________
       ► IP
       ► None of the given
       ► TCP
       ► UDP
Question No: 11      ( Marks: 1 ) - Please choose one
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_______ protocols of TCP/IP layering model specify how to ensure reliable transfer.
       ► Physical Layer
       ► Network Interface Layer 
       ► Internet Layer
       ► Transport Layer
Question No: 12      ( Marks: 1 ) - Please choose one
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________identifies which application program on receiving computer should receive the data
       ► Logical address

Source port

Logical address

None of the given
       ► Source port
       ► Destination Port
       ► None of the given
Question No: 13      ( Marks: 1 ) - Please choose one

[image: image15.wmf] 

 
________ identifies the application program that sent the data. 

       ►  Destination Port
       ► Source port
       ► Logical address
       ► None of the given
Question No: 14      ( Marks: 1 ) - Please choose one

[image: image16.wmf] 

 
Which of the following are interior routing protocols?

       ► RIP

       ► OSPF
       ► BGP
       ► RIP and OSPF
Question No: 15      ( Marks: 1 ) - Please choose one

[image: image17.wmf] 

 
The Border Gateway Protocol (BGP) uses_________ for all communication

       ► UDP
       ► TCP
       ► Both UDP and TCP
       ► None of the given
Question No: 16      ( Marks: 1 ) - Please choose one

[image: image18.wmf] 

 
__________measures distance in network hops, where each network between the source and destination counts as single hop.
       ► BGP
       ► OSPF
       ► RIP
       ► None of the given
Question No: 17      ( Marks: 1 ) - Please choose one
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OSPF is based on--------

       ► Distance vector routing
       ► Link state routing
       ► Path vector routing
       ► Distance vector routing and Link state routing
Question No: 18      ( Marks: 1 ) - Please choose one
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_________ performs local multicast and uses IP-in-IP encapsulation to send multicast datagrams from one site on the Internet to another.

       ► Distance Vector Multicast Routing Protocol (DVMRP)
       ► Core Based Trees (CBT)
       ► Protocol Independent Multicast_ Sparse Mode (PIM-SM)
       ► Protocol Independent Multicast _ Dense Mode (PIM-DM)
Question No: 19      ( Marks: 1 ) - Please choose one
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The length of time required to send a variable length packet is variable and does not require a complicated interrupt scheme to detect completion of transmission. 
       ► True

       ► False

Question No: 20      ( Marks: 1 ) - Please choose one
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NEXT HEADER field in the base header defines type of header and it appears at end of fixed-size base header.
       ► True

       ► False

Question No: 21      ( Marks: 1 ) - Please choose one

[image: image23.wmf] 

 
Although message exchange can be used to bind addresses, sending a request for each binding is hopelessly inefficient.
       ► True

       ► False

Question No: 22      ( Marks: 1 ) - Please choose one

[image: image24.wmf] 

 
Address mask defines how many bits of address are in suffix?
       ► True

       ► False

Question No: 23      ( Marks: 1 ) - Please choose one

[image: image25.wmf] 

 
A computer attached to a given network can only communicate with other computers attached to the same network. Is this a problem with multiple networks?

       ► True

       ► False

Question No: 24      ( Marks: 1 ) - Please choose one
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In the 1970s large organizations began to acquire multiple networks. Each network in the organization formed island. Employees needed to choose a computer appropriate for each task. So they needed multiple screens, keyboards and computers.

       ► False

       ► True

Question No: 25      ( Marks: 1 ) - Please choose one

[image: image27.wmf] 

 
The term self-identifying is used for Classful IP addresses because the class of the address can be computed from the address__________.


       ► itself

       ► prefix

       ► suffix

       ► mask

Question No: 26      ( Marks: 1 ) - Please choose one
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In which method of Address Resolution Protocol the protocol address independent of hardware address?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
       ► T, C

       ► D

       ► C

       ► T, D

Question No: 27      ( Marks: 1 ) - Please choose one

[image: image29.wmf] 

 
In which method of Address Resolution Protocol the protocol address is determined by hardware address? vuattach.ning.com

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
       ► T

       ► D

       ► C

       ► T, C

Question No: 28      ( Marks: 1 ) - Please choose one
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Reconstruction of original datagram is called reassembly.
       ► True

       ► False

Question No: 29      ( Marks: 1 ) - Please choose one
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A computer needs a complete stack of protocols to run either a client or a server.

       ► True

       ► False

Question No: 30      ( Marks: 1 ) - Please choose one
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TCP uses _______ mechanism to control the flow of data.
       ► door

       ► window

       ► acknowledgment

       ► retransmission
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Question No: 1      ( Marks: 1 ) - Please choose one

[image: image33.wmf] 

 
The number of connections needed for N computer in direct point to point communication is equal to:

       ► (N2 –N)/2
       ► N(N- 1)
       ► N2
       ► None of the given
Question No: 2      ( Marks: 1 ) - Please choose one
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When an application--------------- data, it makes a copy of the data available to all other computers on the network.

       ► Broadcasting
       ► Multicasting
       ► Unicasting
       ► None of the given
One repeater _______, two repeaters ________ the maximum cable length limitation.
       ► doubles, cancel
       ► doubles, triple
       ► square roots, cude roots

       ► and, triple
Question No: 12      ( Marks: 1 ) - Please choose one
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Whenever it handles a packet, IP software needs to separate the destination address into a _________ and ___________.
       ► postfix, Infix
       ► non of these

       ► Infix, prefix
       ► prefix, suffix
Ref No: 1578657

Time: 90 min

Marks: 60

Question No: 1      ( Marks: 1 ) - Please choose one

[image: image36.wmf] 

A ---------- relies on the hardware manufacturer to assign a unique physical address to each network interface.

       ► Static addressing scheme

       ► Configurable addressing scheme

       ► Dynamic addressing scheme
      ► None of the given
Question No: 2      ( Marks: 1 ) - Please choose one

[image: image37.wmf] 

An interface for thin  Ethernet must have an ____________  connector , and must generate signals according to the_____________ specification.

       ► RJ-45, 10 Base T

       ► RJ-45, 10 Base 5

       ► BNC, 10 Base 2

       ► BNC, 10 Base T

Question No: 3      ( Marks: 1 ) - Please choose one

[image: image38.wmf] 

A system with redundant bridges might have a problem with_______ in the system.

       ► Loop

       ► Filters

       ► Spanning Trees

       ► All given choices

Question No: 4      ( Marks: 1 ) - Please choose one

A Bridge can ________

       ► Filter a frame

       ► Forward a frame

       ► Extend a LAN

       ► Do all the above

Question No: 5      ( Marks: 1 ) - Please choose one

________ is used for typical data applications (where the data rate may be unknown and bursty) and allows use of whatever bandwidth is available at a given time.

       ► Constant Bit Rate (CBR) service

       ► Variable Bit Rate (VBR) service

       ► Available Bit Rate (ABR) service

       ► None of the given

Question No: 6      ( Marks: 1 ) - Please choose one

[image: image39.wmf] 

ATM assigns each VC a _____________ identifier that is divided two parts to produce a hierarchy.

       ► 21-bit

       ► 22-bit

       ► 23-bit

       ► 24-bit

Question No: 7      ( Marks: 1 ) - Please choose one

[image: image40.wmf] 

________ of TCP/IP layering model, corresponds to basic network hardware.

       ► Physical Layer

       ► Network Interface Layer 

       ► Internet Layer

       ► Transport Layer

Question No: 8      ( Marks: 1 ) - Please choose one

__________ places the boundary between the second and third octets

       ► Class A

       ► Class B

       ► Class C

       ► Class D

Question No: 9      ( Marks: 1 ) - Please choose one

[image: image41.wmf] 


UDP and TCP are both_________ layer protocols

       ► Physical
       ► Data link
       ► Network
       ► Transport

Question No: 10      ( Marks: 1 ) - Please choose one

[image: image42.wmf] 

Connection-oriented service, Point-to-point, Complete reliability, Full-duplex communication, Stream interface, Reliable connection startup and Graceful connection shutdown are the services provided by__________

       ► IP

       ► None of the given

       ► TCP

       ► UDP

Question No: 11      ( Marks: 1 ) - Please choose one

_______ protocols of TCP/IP layering model specify how to ensure reliable transfer.

       ► Physical Layer

       ► Network Interface Layer 

       ► Internet Layer

       ► Transport Layer

Question No: 12      ( Marks: 1 ) - Please choose one

[image: image43.wmf] 

________identifies which application program on receiving computer should receive the data

  ► Logical address

Source port

Logical address

None of the give
       ► Source port

       ► Destination Port

       ► None of the given

Question No: 13      ( Marks: 1 ) - Please choose one
________ identifies the application program that sent the data. 

       ►  Destination Port

       ► Source port

       ► Logical address

       ► None of the given

Question No: 14      ( Marks: 1 ) - Please choose one

[image: image44.wmf] 

Which of the following are interior routing protocols?

       ► RIP

       ► OSPF

       ► BGP

       ► RIP and OSPF

Question No: 15      ( Marks: 1 ) –www.vustudents.ning.com  Please choose one

[image: image45.wmf] 

The Border Gateway Protocol (BGP) uses_________ for all communication

       ► UDP

       ► TCP

       ► Both UDP and TCP

       ► None of the given

Question No: 16      ( Marks: 1 ) - Please choose one

__________measures distance in network hops, where each network between the source and destination counts as single hop.

       ► BGP

       ► OSPF

       ► RIP

       ► None of the given

Question No: 17      ( Marks: 1 ) - Please choose one

[image: image46.wmf] 

OSPF is based on--------

       ► Distance vector routing

       ► Link state routing

       ► Path vector routing

       ► Distance vector routing and Link state routing

Question No: 18      ( Marks: 1 ) - Please choose one

[image: image47.wmf] 

_________ performs local multicast and uses IP-in-IP encapsulation to send multicast datagrams from one site on the Internet to another.

      ► Distance Vector Multicast Routing Protocol (DVMRP)

       ► Core Based Trees (CBT)

       ► Protocol Independent Multicast_ Sparse Mode (PIM-SM)
       ► Protocol Independent Multicast _ Dense Mode (PIM-DM)
Question No: 19      ( Marks: 1 ) - Please choose one
The length of time required to send a variable length packet is variable and does not require a complicated interrupt scheme to detect completion of transmission. 

       ► True
       ► False
Question No: 20      ( Marks: 1 ) - Please choose one

[image: image48.wmf] 

NEXT HEADER field in the base header defines type of header and it appears at end of fixed-size base header.

       ► True

       ► False

Question No: 21      ( Marks: 1 ) - Please choose one

[image: image49.wmf] 

Although message exchange can be used to bind addresses, sending a request for each binding is hopelessly inefficient.

       ► True

       ► False

Question No: 22      ( Marks: 1 ) - Please choose one

Address mask defines how many bits of address are in suffix?

       ► True

       ► False

Question No: 23      ( Marks: 1 ) - Please choose one

A computer attached to a given network can only communicate with other computers attached to the same network. Is this a problem with multiple networks?

       ► True

       ► False

Question No: 24      ( Marks: 1 ) - Please choose one

[image: image50.wmf] 

In the 1970s large organizations began to acquire multiple networks. Each network in the organization formed island. Employees needed to choose a computer appropriate for each task. So they needed multiple screens, keyboards and computers.

       ► False

       ► True

Question No: 25      ( Marks: 1 ) - Please choose one

[image: image51.wmf] 

The term self-identifying is used for Classful IP addresses because the class of the address can be computed from the address__________.


       ► itself

       ► prefix

       ► suffix

       ► mask

Question No: 26      ( Marks: 1 ) - Please choose one

[image: image52.wmf] 

In which method of Address Resolution Protocol the protocol address independent of hardware address?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
       ► T, C

       ► D

       ► C

       ► T, D

Question No: 27      ( Marks: 1 ) - Please choose one

[image: image53.wmf] 

In which method of Address Resolution Protocol the protocol address is determined by hardware address?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
       ► T

       ► D

       ► C

       ► T, C

Question No: 28      ( Marks: 1 ) - Please choose one

[image: image54.wmf] 

Reconstruction of original datagram is called reassembly.

       ► True

       ► False

Question No: 29      ( Marks: 1 ) - Please choose one

[image: image55.wmf] 

A computer needs a complete stack of protocols to run either a client or a server.

       ► True

       ► False

Question No: 30      ( Marks: 1 ) - Please choose one

[image: image56.wmf] 

TCP uses _______ mechanism to control the flow of data.

       ► door

       ► window

       ► acknowledgment

       ► retransmission

                                 FINALTERM EXAMINATION 

Question No: 1      ( Marks: 1 ) - Please choose one
Computer networks are often called -------------- because they use packet technology.
       ► Ethernet
       ► Switch networks
       ► Packet networks
        ► None of the given
 Question No: 2      ( Marks: 1 ) - Please choose one
A network uses a ------arranges for computers to be connected in a closed loop.
       ► Star Topology
       ► Ring Topology
        ► Bus Topology
        ► None of the given
 In a ring topology each computer is connected to other thorough a ring
Question No: 3      ( Marks: 1 ) - Please choose one
An ------------method, the network hardware designers specify how type information is included in the frame and the value use to identify various frame types.
       ► Explicit frame type
        ► Ideal frame type
        ► Implicit frame type
        ► None of the given
EXPLICIT FRAME TYPE:
In this type the identifying value is included with frame describes types of
included data.
Question No: 4      ( Marks: 1 ) - Please choose one
An interface for thin Ethernet must have an ____________ connector , and must generate signals according to the_____________ specification.
       ► RJ-45, 10 Base T (reference not available)
        ► RJ-45, 10 Base 5
        ► BNC, 10 Base 2
        ► BNC, 10 Base T
Question No: 5      ( Marks: 1 ) - Please choose one
A Bridge forwards or filters a frame by comparing the information in its address table to the frame’s__________
       ► Layer 2 source address
        ► Source node’s physical address
        ► Layer 2 destination address     (not confirm)
       ► Layer 3 destination address
 Question No: 6      ( Marks: 1 ) - Please choose one
Most WAN systems include a mechanism that can be used to eliminate the common case of duplication routing is called___________
        ► Hierarchal address
        ► Default route
        ► Shortest path
       ► None of the given
Most WAN systems include a mechanism that can be used to eliminate the common case of duplication routing is called Default route. The mechanism allows a single entry in a forwarding table to replace a long list of entries that have the same next hope value
Question No: 7      ( Marks: 1 ) - Please choose one
________ of TCP/IP layering model, corresponds to basic network hardware.
       ► Physical Layer
       ► Network Interface Layer
        ► Internet Layer
      ► Transport Layer
LAYER 1:
Corresponds to basic network hardware layer in OSI
Question No: 8      ( Marks: 1 ) - Please choose one
_______ protocols of TCP/IP layering model specify how to ensure reliable transfer.
       ► Physical Layer
       ► Network Interface Layer
        ► Internet Layer
       ► Transport Layer
 The Internet layer in the TCP/IP reference model is responsible for transferring data between the source and destination computers
Question No: 9      ( Marks: 1 ) - Please choose one
________is called an end-to-end protocol because it provide a connection directly from an application on one computer to an application on a remote computer.
       ► IP
       ► UDP
        ► TCP
        ► None of the given
UDP has the following characteristics.
It is an end-to-end protocol. It provides application-to-application communication.
Question No: 10      ( Marks: 1 ) - Please choose one
____________ uses distance vector approach to define routing
       ► BGP
      ► OSPF
        ► RIP
        ► None of the given
 DISTANCE-VECTOR ROUTING:
• It is very simple to implement.
• Packet switch updates its own routing table first.
• It is used in RIP.
Question No: 11      ( Marks: 1 ) - Please choose one
_______    is ideal in a situation where the group is small and all members are attached to contiguous Local Area Networks.
       ► Flood-and -Prune
        ► Configuration-and -Tunneling
       ► Core-Based Discovery
       ► None of the give006E
FLOOD-AND-PRUNE:
Flood-and-prune is ideal in a situation where the group is small and all members
Are attached to contiguous Local Area Networks.
Question No: 12      ( Marks: 1 ) - Please choose one
Router that decrements TTL to __ sends ICMP time exceeded message, with router’s address as source address
       ► 3
       ► 2
       ► 1
       ► 0
Router that decrements TTL to 0 sends ICMP time exceeded message, with router’s
address as source address
Question No: 13      ( Marks: 1 ) - Please choose one
Protocol addresses are abstractions provided by ___________.
       ► hardware
       ► software
       ► operating system
       ► internet
PROTOCOL ADDRESSES AND PACKET DELIVERY:
Protocol addresses are abstractions provided by software
Question No: 14      ( Marks: 1 ) - Please choose one
Although message exchange can be used to bind addresses, sending a request for each binding is hopelessly inefficient.
       ► True
       ► False
 CASHING ARP RESPONSES:
Although message exchange can be used to bind addresses, sending a request for
each binding is hopelessly inefficient
 Question No: 15      ( Marks: 1 ) - Please choose one
ARP is almost always used to bind a ___-bit IP address to a ___-bit Ethernet address.
       ► 32, 48
       ► 24, 32
       ► 32, 64
       ► 32, 128
 ARP is almost always used to bind a 32-bit IP address to a 48-bit Ethernet address
Question No: 16      ( Marks: 1 ) - Please choose one
In the 1970s large organizations began to acquire multiple networks. Each network in the organization formed island. Employees needed to choose a computer appropriate for each task. So they needed multiple screens, keyboards and computers.
        ► False
        ► True
 HYPERLINK "http://www.vuzs.net/" 


 HYPERLINK "http://groups.google.com/group/vuzs" 
In the 1970s large organizations began to acquire multiple networks. Each
network in the organization formed island. Employees needed to choose a
computer appropriate for each task. So they needed multiple screens, keyboards
and computers.
Question No: 17      ( Marks: 1 ) www.vustudents.ning.com  - Please choose one
In which method of Address Resolution Protocol the protocol address is determined by hardware address?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
	
Features
 
	Types of
Resolution

	Use full with any hardware
	T

	Address change affects all hosts
	T

	Protocol address is determined by hardware address
	C


       ► T
       ► D
       ► C
       ► T, C
Question No: 18      ( Marks: 1 ) - Please choose one
 
The general form of an IP datagram is with a header followed by data. The header contains information that controls where and how the datagram is to be sent.
       ► True
       ► False
·    Header contains all information needed to deliver datagram to the destination
computer. It contains:
• Destination address
• Source address
• Identifier
• Other delivery information 
Question No: 19      ( Marks: 1 ) - Please choose one
To save traffic, an EGP does not summerize routing information from the autonomous system before passing it to another autonomous system.
       ► True
       ► False
"It provides routing among autonomous systems (EGP).
Question No: 20      ( Marks: 1 ) - Please choose one
Which of the following is a correct representation of the IPv6?
       ► 105.220.136.100.255.255.255.255.0.0.18.128.140.10.255.255 
       ► 105.220.136.100.255.255.255.256.0.0.18.128.140.10.255.255 
       ► 105.220.136.100.255.255.255.255.0.0.18.128.140.10.255.255.256
       ► 105.220.136.100.255.255.255.255.0.0.18.128.140.10.255
128-bit addresses unwidely in dotted decimal; requires 16 numbers:
105.220.136.100.255.255.255.255.0.0.18
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 Question No: 1      ( Marks: 1 ) - Please choose one
 The number of connections needed for N computer in direct point to point communication is equal to:
        ► (N2 –N)/2
        ► N(N- 1)
       ► N2
        ► None of the given
For ‘n’ computers connections in direct point to point communication = (n^2 –n)/2.
                           
Question No: 2      ( Marks: 1 ) - Please choose one
When an application--------------- data, it makes a copy of the data available to all other computers on the network.
       ► Broadcasting
        ► Multicasting
        ► Unicasting
        ► None of the given (not sure)
 Question No: 3      ( Marks: 1 ) - Please choose one
Ethernet uses a ------ bit static addressing scheme in which each device is assigned a unique address by the manufacturer.
       ► 64
        ► 48
        ► 32
        ► 8
Ethernet uses a 48-bit static addressing scheme
 Question No: 4      ( Marks: 1 ) - Please choose one
 A system with redundant bridges might have a problem with_______ in the system.
        ► Loop
        ► Filters
        ► Spanning Trees
        ► All given choices
 Reference not available
Question No: 5      ( Marks: 1 ) - Please choose one
The product of delay and throughput measures the _____ of data that can be present on the network.
        ► Area
        ► Volume
        ► Length
        ► None of the given
It is computed as delay time multiplied by effective throughput. It measures amount of data that can be present in the network
Question No: 6      ( Marks: 1 ) - Please choose one
Connectionless service, Message-Oriented protocol, best effort delivery service, arbitrary interaction and operating system independent are the characteristics of _____________
        ► TCP
        ► UDP
        ► IP
        ► None of the given
 UDP has the following characteristics.
• It is an end-to-end protocol. It provides application-to-application communication.
• It provides connectionless service.
• It is a Message-Oriented protocol.
• It uses best-effort delivery service.
• It follows arbitrary interaction.
• It is operating system independent
 Question No: 7      ( Marks: 1 ) - Please choose one
 Connection-oriented service, Point-to-point, Complete reliability, Full-duplex communication, Stream interface, Reliable connection startup and Graceful connection shutdown are the services provided by__________
        ► None of the given
        ► TCP
        ► UDP
        ► IP
SERVICE PROVIDED BY TCP:
Following are the services provided by TCP:
• Connection-oriented service
• Point-to-point
• Complete reliability
• Full-duplex communication
• Stream interface
• Reliable connection startup
• Graceful connection shutdown
Question No: 8      ( Marks: 1 ) - Please choose one
The process of using a routing table to select a next hop for a given datagram is called_________
        ► Encapsulation
        ► Reassembling
        ► Routing or forwarding 
        ► None of the given
Reference not available
 Question No: 9      ( Marks: 1 ) www.vustudents.ning.com  - Please choose one
____________ uses distance vector approach to define routing
        ► BGP
        ► OSPF
        ► RIP
        ► None of the given
DISTANCE-VECTOR ROUTING:
• It is very simple to implement.
• Packet switch updates its own routing table first.
• It is used in RIP.
Question No: 10      ( Marks: 1 ) - Please choose one
A multicast routing scheme in which the protocol software builds a delivery tree from a central point is called__________
       ► Distance Vector Multicast Routing Protocol (DVMRP)
        ► Core Based Trees (CBT)
        ► Protocol Independent Multicast_ Sparse Mode (PIM-SM)
        ► Protocol Independent Multicast _ Dense Mode (PIM-DM)
 CORE BASED TREES (CBT):
A multicast routing scheme in which the protocol software builds a delivery tree
from a central point.
 Question No: 11      ( Marks: 1 ) - Please choose one
 One repeater _______, two repeaters ________ the maximum cable length limitation.
       ► doubles, cancel
        ► doubles, triple
        ► square roots, cude roots
        ► and, triple
 One repeater doubles, two repeaters triple the maximum cable length limitation.
Question No: 12      ( Marks: 1 ) - Please choose one
Whenever it handles a packet, IP software needs to separate the destination address into a _________ and ___________.
        ► postfix, Infix
        ► non of these
        ► Infix, prefix
        ► prefix, suffix
 Whenever it handles a packet, IP software needs to separate the destination address into a prefix and suffix
Question No: 13      ( Marks: 1 ) - Please choose one
 Although message exchange can be used to bind addresses, sending a request for each binding is hopelessly inefficient.
        ► True
        ► False
CASHING ARP RESPONSES:
Although message exchange can be used to bind addresses, sending a request for
each binding is hopelessly inefficient.
Question No: 14      ( Marks: 1 ) - Please choose one
 ARP is almost always used to bind a ___-bit IP address to a ___-bit Ethernet address.
        ► 32, 48
        ► 24, 32
        ► 32, 64
        ► 32, 128
ARP is almost always used to bind a 32-bit IP address
to a 48-bit Ethernet address
 Question No: 15      ( Marks: 1 ) - Please choose one
 End-to-end delivery service is connection oriented.
        ► True
        ► False       
End-to-end delivery service is connection less
Question No: 16      ( Marks: 1 ) - Please choose one
 A single networking technology is best for all needs.
 
       ► True
 
       ► False

There is no single networking technology that is best for all needs
Question No: 17      ( Marks: 1 ) - Please choose one
In the 1970s large organizations began to acquire multiple networks. Each network in the organization formed island. Employees needed to choose a computer appropriate for each task. So they needed multiple screens, keyboards and computers.
       ► False
       ► True
In the 1970s large organizations began to acquire multiple networks. Each network in the organization formed island. Employees needed to choose a computer appropriate for each task. So they needed multiple screens, keyboards and computers.
Question No: 18      ( Marks: 1 ) - Please choose one
Which method of Address Resolution Protocol is useful with any hardware?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
	Features
 
	Types of
Resolution

	Use full with any hardware
	T

	Address change affects all hosts
	T

	Protocol address is determined by hardware address
	C


       ► T
        ► C
        ► D
        ► C, D
 
 
 
Question No: 19      ( Marks: 1 ) - Please choose one
In which method of Address Resolution Protocol the protocol address is determined by hardware address?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
	Features
 
	Types of
Resolution

	Use full with any hardware
	T

	Address change affects all hosts
	T

	Protocol address is determined by hardware address
	C


        ► T
        ► D
        ► C
        ► T, C
 
 
Question No: 20      ( Marks: 1 ) - Please choose one
We use the term _______ to refer to a measure of the path that routing software use when choosing a route.
        ► routing path
        ► routing metric
        ► routing
         switching
 We use the termrouting metric to refer to a measure of the path that routing software use when choosing a route
CS610- Computer Network
Question No: 1 ( Marks: 1 ) - Please choose one
In Direct point to point communication adding the Nth computer requires------------ new connections.
► None of the given
► N2
► N-1
► (N2 –N)/2
disadvantage In Direct point to point communication is that adding a new computer to the network requires N-1 new connections .(P# 23)
Question No: 2 ( Marks: 1 ) - Please choose one
In Point-to-Point topology there are two topologies.

► Tree and Ring
► Star and Ring
► Star and Tree
► None of the given
POINT-TO-POINT:
In Point-to-Point topology there are two topologies.
1) STAR topology
2) TREE topology
Question No: 3 ( Marks: 1 ) - Please choose one

 BORDER GATEWAY PROTOCOL:
It is most popular Exterior Gateway Protocol in Internet. It has following characteristics:
"It provides routing among autonomous systems (EGP).
"It provides policies to control routes advertised.
"It uses reliable transport (TCP).

Unicast: It is used for single destination computer.
Multicast: It is used for multiple destinations; possibly not at same site.
Cluster: This type of address is used for collection of computers with same prefix,
datagram is delivered to one out of cluster.
Question No: 45 ( Marks: 1 ) - Please choose one
Special types of addresses in IPv6 used for multiple destinations; possibly not at same site. Are known as_________.
► Unicast
► Anycast
► Multicast
► Non of the given
Following are special types of addresses, IPv6 uses:
Unicast: It is used for single destination computer.
Multicast: It is used for multiple destinations; possibly not at same site.
Cluster: This type of address is used for collection of computers with same prefix,
datagram is delivered to one out of cluster.
Question No: 46 ( Marks: 1 ) - Please choose one
UDP offers application programs a Message-Oriented Interface, applications can depend on protocol to preserve data boundaries.
► True
► False
UDP offers application programs a Message-Oriented Interface. It does not divide messages into packets for transmission and does not combine messages for delivery.
ADVANTAGES:
• Applications can depend on protocol to preserve data boundaries.
Question No: 47 ( Marks: 1 ) - Please choose one
Reliability is the responsibility of the _________ layer
► Network
► Datalink
► Transport
► Application
Reliability is the responsibility of the Transport layer
Question No: 48 ( Marks: 1 ) - Please choose one
TCP uses _______ mechanism to control the flow of data.
► door
► window
► acknowledgment
► retransmission
TCP uses window mechanism to control the flow of data.
Question No: 49 ( Marks: 1 ) - Please choose one
The time for acknowledgement to arrival of packet depends on.
► Distance to destination and Current traffic conditions
► Current traffic conditions
► Distance to destination
► non of these
The time for acknowledgement to arrive depends on:
• Distance to destination
• Current traffic conditions
Question No: 50 ( Marks: 1 ) - Please choose one
FDDI can transmits data at a rate of ----------
► 100 million bits per second
► 10 million bits per second
► 1000 million bits per second
► None of the given
FDDI: Fiber distributed data interconnect (FDDI) is another ring technology. Its most
important features are:
It uses fiber optics between stations and transmits data at 100Mbps.

        ► C (Supposition)

        ► D

        ► C, D

9) In which method of Address Resolution Protocol the protocol address is determined by hardware address?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
       ► T

        ► D

        ► C
        ► T, C

10 )We use the term _______ to refer to a measure of the path that routing software use when choosing a route.

        ► routing path

        ► routing metric
        ► routing

        ► switching

11) A network uses a ------arranges for computers to be connected in a closed loop.

        ► Star Topology

       ► Ring Topology
       ► Bus Topology

       ► None of the given

12) An interface for thin  Ethernet must have an ____________  connector , and must generate signals according to the_____________ specification. 

       ► RJ-45, 10 Base T
        ► RJ-45, 10 Base 5

        ► BNC, 10 Base 2

       ► BNC, 10 Base T

13) _______ protocols of TCP/IP layering model specify how to ensure reliable transfer.

       ► Physical Layer

      ► Network Interface Layer 

       ► Internet Layer

       ► Transport Layer
14)____________ uses distance vector approach to define routing

        ► BGP

       ► OSPF

       ► RIP
       ► None of the given
Fall 2008
1) When an application--------------- data, it makes a copy of the data available to all other computers on the network.

       ► Broadcasting
        ► Multicasting

        ► Unicasting

       ► None of the given

2) Ethernet uses a ------ bit static addressing scheme in which each device is assigned a unique address by the manufacturer. 

       ► 64

        ► 48
        ► 32

        ► 8

3) The product of delay and throughput measures the _____ of data that can be present on the network.

      ► Area

        ► Volume (supposition)

        ► Length

        ► None of the given

  4) Connectionless service, Message-Oriented protocol, best effort delivery service, arbitrary interaction and operating system independent are the characteristics of _____________

        ► TCP

        ► UDP
        ► IP

        ► None of the given

  5) ____________ uses distance vector approach to define routing

        ► BGP

        ► OSPF

        ► RIP
        ► None of the given

6) Whenever it handles a packet, IP software needs to separate the destination address into a _________ and ___________.

        ► postfix, Infix

        ► non of these

        ► Infix, prefix

        ► prefix, suffix
7) ARP is almost always used to bind a ___-bit IP address to a ___-bit Ethernet address.

       ► 32, 48
        ► 24, 32

        ► 32, 64

        ► 32, 128

8) Which method of Address Resolution Protocol is useful with any hardware?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
       ► T
Question No: 1      ( Marks: 1 ) - Please choose one

[image: image57.wmf] 


________ encapsulates IP datagram as data area in hardware frame.

1. Network Interface Layer
2. Datalink Layer

3. Network Layer

4. None of the given

Question No: 2     ( Marks: 1 ) - Please choose one
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________ field is used to identify a specific path through the network

1. FLOW LABEL

2. TRAFFIC CLASS

3. Both a and b
4. none of the given

Question No: 3      ( Marks: 1 ) - Please choose one
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IPV6 address with ______ leading zeros is interpreted to hold an IPV4 address.

1. 96
2. 100

3. 120

4. none of the given

Question No: 4      ( Marks: 1 ) - Please choose one
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Although the ARP message format is sufficiently general to allow arbitrary protocol and hardware addresses. ARP is almost always used to bind a 32-bit IP address to a ____ Ethernet address. 

1. Answer (48bit)
Question No: 5      ( Marks: 1 ) - Please choose one
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For _____________, information about forwarding is stored in a routing table, which is initialized at system initialization and must be updated as network topology changes.

1. Efficiency
2. Security

3. Accuracy

4. Anomalies

Question No: 6      ( Marks: 1 ) - Please choose one
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_______ is a technique used to Limit datagram size to small MTU of any network

1. Segmentation

2. Fragmentation
3. Encapsulation

4. none of the given

Question No: 7      ( Marks: 1 ) - Please choose one
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Class A mask is 255.0.0.0 which is used for ______

1. Unicasting

2. Multicasting

3. Subnetting
4. All of the given

Question No: 8      ( Marks: 1 ) - Please choose one
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When one computer sends an ARP message to another the message travels inside the hardware frame. Technically, placing a message inside a frame for transport is not called encapsulation.

1. True

2. False
Question No: 9      ( Marks: 1 ) - Please choose one
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Which one of these is not a main feature of connectionless service:

1. It includes extension of LAN abstraction.

It has
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Preliminary version of IP was called _________. 
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Select correct option: 
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___________ places the boundary between the second and third octets 
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Select correct option: 
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For _____________, information about forwarding is stored in a routing table, which is initialized at system initialization and must be updated as network topology changes. 

[image: image97.png]


Select correct option: 
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	Question # 4 of 15 ( Start time: 11:49:37 AM ) 

Total Marks: 1 

________ field of header indicates whether a datagram is a fragment or a complete datagram. 

[image: image111.png]


Select correct option: 
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	Question # 5 of 15 ( Start time: 11:50:23 AM ) 

Total Marks: 1 

___________ places the boundary between the first and second octets 
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Select correct option: 
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	Question # 6 of 15 ( Start time: 11:50:52 AM ) 

Total Marks: 1 

Mapping between a protocol address and a hardware address is called Address Resolution. 
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Select correct option: 
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	Question # 7 of 15 ( Start time: 11:51:38 AM ) 

Total Marks: 1 

TCP/IP defines the term__________ to refer any computer system that connects to an internet and runs applications 
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Select correct option: 
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	Question # 8 of 15 ( Start time: 11:52:42 AM ) 

Total Marks: 1 

________ encapsulates IP datagram as data area in hardware frame. 
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Select correct option: 
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	Question # 9 of 15 ( Start time: 11:53:17 AM ) 

Total Marks: 1 

______ contains all information needed to deliver datagram to the destination. 
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Select correct option: 
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	Question # 10 of 15 ( Start time: 11:53:53 AM ) 

Total Marks: 1 

The Internet service providers coordinate with the Internet assigned number authority to obtain their network numbers. 
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Select correct option: 
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	Question # 11 of 15 ( Start time: 11:54:26 AM ) 

Total Marks: 1 

Although the ARP message format is sufficiently general to allow arbitrary protocol and hardware addresses. ARP is almost always used to bind a 32-bit IP address to a ____ Ethernet address. 
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Select correct option: 
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	Question # 12 of 15 ( Start time: 11:54:53 AM ) 

Total Marks: 1 

The Current version of IP-Version 4 is _____ old 
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Select correct option: 
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	Question # 13 of 15 ( Start time: 11:55:16 AM ) 

Total Marks: 1 

Whenever it handles a packet, IP software needs to separate the destination address into a prefix. 
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Select correct option: 
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	Question # 14 of 15 ( Start time: 11:56:03 AM ) 

Total Marks: 1 

When one computer sends an ARP message to another the message travels inside the hardware frame. Technically, placing a message inside a frame for transport is not called encapsulation. 
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	Question # 15 of 15 ( Start time: 11:56:43 AM ) 

Total Marks: 1 

In ______________, the protocol address assigned to a computer is chosen carefully so that computer’s hardware address can be computed from the protocol address using basic Boolean and arithmetic operations. 

[image: image249.png]


Select correct option: 
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	Question # 1 of 15 ( Start time: 12:01:47 PM ) 

Total Marks: 1 

There are three standard implementations to improve computational efficiency: Hashing, Direct Indexing and InDirect Indexing 
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Select correct option: 
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Question No: 1      ( Marks: 1 ) - Please choose one
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________ encapsulates IP datagram as data area in hardware frame.
5. Network Interface Layer
6. Datalink Layer

7. Network Layer

8. None of the given
Question No: 2     ( Marks: 1 ) - Please choose one
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________ field is used to identify a specific path through the network

5. FLOW LABEL

6. TRAFFIC CLASS

7. Both a and b
8. none of the given
Question No: 3      ( Marks: 1 ) - Please choose one
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IPV6 address with ______ leading zeros is interpreted to hold an IPV4 address.
5. 96
6. 100

7. 120

8. none of the given
Question No: 4      ( Marks: 1 ) - Please choose one
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Although the ARP message format is sufficiently general to allow arbitrary protocol and hardware addresses. ARP is almost always used to bind a 32-bit IP address to a ____ Ethernet address. 
2. Answer (48bit)
Question No: 5      ( Marks: 1 ) - Please choose one
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For _____________, information about forwarding is stored in a routing table, which is initialized at system initialization and must be updated as network topology changes.

5. Efficiency
6. Security

7. Accuracy

8. Anomalies
Question No: 6      ( Marks: 1 ) - Please choose one
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_______ is a technique used to Limit datagram size to small MTU of any network

5. Segmentation

6. Fragmentation
7. Encapsulation

8. none of the given
Question No: 7      ( Marks: 1 ) - Please choose one
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Class A mask is 255.0.0.0 which is used for ______
5. Unicasting

6. Multicasting

7. Subnetting
8. All of the given
Question No: 8      ( Marks: 1 ) - Please choose one
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When one computer sends an ARP message to another the message travels inside the hardware frame. Technically, placing a message inside a frame for transport is not called encapsulation.

3. True

4. False
Question No: 9      ( Marks: 1 ) - Please choose one
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Which one of these is not a main feature of connectionless service:

2. It includes extension of LAN abstraction.

3. It has universal addressing and the data is delivered in packets frames), each with a header

4. It combines collection of physical networks into a single virtual network.

5. It has universal addressing and the data is delivered in packets frames), without a header
Question No: 10     ( Marks: 1 ) - Please choose one
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Which protocol is used to test different tools.

1. ICMP
2. IGMP

3. TCP/IP

4. none of the given
Question No: 11      ( Marks: 1 ) - Please choose one
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________ message is sent in response to incoming datagrams with problems.
1. TCP/IP

2. IGMP

3. ICMP
4. none of the given
Question No: 12     ( Marks: 1 ) - Please choose one

[image: image281.wmf] 


Which one is NOT the function of ping program
1. Traceability

2. Reach ability
3. Both a and b

4. None of the given
Question No: 13      ( Marks: 1 ) - Please choose one
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IPV6 address with ______ leading zeros is interpreted to hold an IPV4 address.
1. 96
2. 100

3. 120

4. none of the given
Question No: 14      ( Marks: 1 ) - Please choose one
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A datagram cannot be larger than ________ of a network over which it is sent.
1. MTU
2. Size

3. IP header

4. None of the given
Question No: 15      ( Marks: 1 ) - Please choose one
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The Source can configure outgoing datagram’s to avoid _________
1. Segmentation

2. Defragmentation
3. Fragmentation

4. None of the given
Question No: 16      ( Marks: 1 ) - Please choose one
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Which one of these is not a main feature of connectionless service:

1. It includes extension of LAN abstraction.

2. has universal addressing and the data is delivered in packets frames), each with a header.

3. It combines collection of physical networks into a single virtual network.

4. It has universal addressing and the data is delivered in packets frames), without a header.
Question No: 17      ( Marks: 1 ) - Please choose one
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Every hardware technology specification includes the definition of the maximum size of the frame data area, which is called the ____________ Transmission Unit

1. Least

2. Maximum
3. Fragment

4. Frame
Question No: 18      ( Marks: 1 ) - Please choose one
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_____ Protocol provides error reporting mechanism.

1. IGMP

2. SNMP

3. ICMP
4. none of the given
Question No: 19      ( Marks: 1 ) - Please choose one
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______ Source is responsible for fragmentation.

1. IPV4

2. IPV6
Question No: 20      ( Marks: 1 ) - Please choose one
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MTU Stands for _______

1. Mininum transmission unit

2. Maximum transmission unit
3. Multicast transmission unit

4. None of the given
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Question No: 1      ( Marks: 1 ) - Please choose one

[image: image290.wmf] 

A ---------- relies on the hardware manufacturer to assign a unique physical address to each network interface.

       ► Static addressing scheme

       ► Configurable addressing scheme

       ► Dynamic addressing scheme
      ► None of the given
Question No: 2      ( Marks: 1 ) - Please choose one

[image: image291.wmf] 

An interface for thin  Ethernet must have an ____________  connector , and must generate signals according to the_____________ specification.

       ► RJ-45, 10 Base T

       ► RJ-45, 10 Base 5

       ► BNC, 10 Base 2

       ► BNC, 10 Base T

Question No: 3      ( Marks: 1 ) - Please choose one

[image: image292.wmf] 

A system with redundant bridges might have a problem with_______ in the system.

       ► Loop

       ► Filters

       ► Spanning Trees

       ► All given choices

Question No: 4      ( Marks: 1 ) - Please choose one

A Bridge can ________

       ► Filter a frame

       ► Forward a frame

       ► Extend a LAN

       ► Do all the above

Question No: 5      ( Marks: 1 ) - Please choose one

________ is used for typical data applications (where the data rate may be unknown and bursty) and allows use of whatever bandwidth is available at a given time.

       ► Constant Bit Rate (CBR) service

       ► Variable Bit Rate (VBR) service

       ► Available Bit Rate (ABR) service

       ► None of the given

Question No: 6      ( Marks: 1 ) - Please choose one

[image: image293.wmf] 

ATM assigns each VC a _____________ identifier that is divided two parts to produce a hierarchy.

       ► 21-bit

       ► 22-bit

       ► 23-bit

       ► 24-bit

Question No: 7      ( Marks: 1 ) - Please choose one

[image: image294.wmf] 

________ of TCP/IP layering model, corresponds to basic network hardware.

       ► Physical Layer

       ► Network Interface Layer 

       ► Internet Layer

       ► Transport Layer

Question No: 8      ( Marks: 1 ) - Please choose one

__________ places the boundary between the second and third octets

       ► Class A

       ► Class B
       ► Class C
       ► Class D

Question No: 9      ( Marks: 1 ) - Please choose one
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UDP and TCP are both_________ layer protocols

       ► Physical
       ► Data link
       ► Network
       ► Transport

Question No: 10      ( Marks: 1 ) - Please choose one

[image: image296.wmf] 

Connection-oriented service, Point-to-point, Complete reliability, Full-duplex communication, Stream interface, Reliable connection startup and Graceful connection shutdown are the services provided by__________

       ► IP

       ► None of the given

       ► TCP

       ► UDP

Question No: 11      ( Marks: 1 ) - Please choose one

_______ protocols of TCP/IP layering model specify how to ensure reliable transfer.

       ► Physical Layer

       ► Network Interface Layer 

       ► Internet Layer

       ► Transport Layer

Question No: 12      ( Marks: 1 ) - Please choose one

[image: image297.wmf] 

________identifies which application program on receiving computer should receive the data

  ► Logical address

Source port

Logical address

None of the give
       ► Source port

       ► Destination Port

       ► None of the given

Question No: 13      ( Marks: 1 ) - Please choose one
________ identifies the application program that sent the data. 

       ►  Destination Port

       ► Source port

       ► Logical address

       ► None of the given

Question No: 14      ( Marks: 1 ) - Please choose one

[image: image298.wmf] 

Which of the following are interior routing protocols?

       ► RIP

       ► OSPF

       ► BGP

       ► RIP and OSPF

Question No: 15      ( Marks: 1 ) - Please choose one

[image: image299.wmf] 

The Border Gateway Protocol (BGP) uses_________ for all communication

       ► UDP

       ► TCP

       ► Both UDP and TCP

       ► None of the given

Question No: 16      ( Marks: 1 ) - Please choose one

__________measures distance in network hops, where each network between the source and destination counts as single hop.

       ► BGP

       ► OSPF

       ► RIP

       ► None of the given

Question No: 17      ( Marks: 1 ) - Please choose one
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OSPF is based on--------

       ► Distance vector routing

       ► Link state routing

       ► Path vector routing

       ► Distance vector routing and Link state routing

Question No: 18      ( Marks: 1 ) - Please choose one

[image: image301.wmf] 

_________ performs local multicast and uses IP-in-IP encapsulation to send multicast datagrams from one site on the Internet to another.

      ► Distance Vector Multicast Routing Protocol (DVMRP)

       ► Core Based Trees (CBT)

       ► Protocol Independent Multicast_ Sparse Mode (PIM-SM)
       ► Protocol Independent Multicast _ Dense Mode (PIM-DM)
Question No: 19      ( Marks: 1 ) - Please choose one
The length of time required to send a variable length packet is variable and does not require a complicated interrupt scheme to detect completion of transmission. 

       ► True
       ► False
Question No: 20      ( Marks: 1 ) - Please choose one

[image: image302.wmf] 

NEXT HEADER field in the base header defines type of header and it appears at end of fixed-size base header.

       ► True

       ► False

Question No: 21      ( Marks: 1 ) - Please choose one

[image: image303.wmf] 

Although message exchange can be used to bind addresses, sending a request for each binding is hopelessly inefficient.

       ► True

       ► False

Question No: 22      ( Marks: 1 ) - Please choose one

Address mask defines how many bits of address are in suffix?

       ► True

       ► False

Question No: 23      ( Marks: 1 ) - Please choose one

A computer attached to a given network can only communicate with other computers attached to the same network. Is this a problem with multiple networks?

       ► True

       ► False

Question No: 24      ( Marks: 1 ) - Please choose one

[image: image304.wmf] 

In the 1970s large organizations began to acquire multiple networks. Each network in the organization formed island. Employees needed to choose a computer appropriate for each task. So they needed multiple screens, keyboards and computers.

       ► False

       ► True

Question No: 25      ( Marks: 1 ) - Please choose one

[image: image305.wmf] 

The term self-identifying is used for Classful IP addresses because the class of the address can be computed from the address__________.


       ► itself

       ► prefix

       ► suffix

       ► mask

Question No: 26      ( Marks: 1 ) - Please choose one

[image: image306.wmf] 

In which method of Address Resolution Protocol the protocol address independent of hardware address?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
       ► T, C

       ► D

       ► C

       ► T, D

Question No: 27      ( Marks: 1 ) - Please choose one

[image: image307.wmf] 

In which method of Address Resolution Protocol the protocol address is determined by hardware address?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
       ► T

       ► D

· ► C

       ► T, C

Question No: 28      ( Marks: 1 ) - Please choose one

[image: image308.wmf] 

Reconstruction of original datagram is called reassembly.

       ► True

       ► False

Question No: 29      ( Marks: 1 ) - Please choose one

[image: image309.wmf] 

A computer needs a complete stack of protocols to run either a client or a server.

       ► True

       ► False

Question No: 30      ( Marks: 1 ) - Please choose one

[image: image310.wmf] 

TCP uses _______ mechanism to control the flow of data.

       ► door

       ► window

       ► acknowledgment

       ► retransmission
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Question No: 1      ( Marks: 1 ) - Please choose one
Computer networks are often called -------------- because they use packet technology.
       ► Ethernet
       ► Switch networks
       ► Packet networks
        ► None of the given
 Question No: 2      ( Marks: 1 ) - Please choose one
A network uses a ------arranges for computers to be connected in a closed loop.
       ► Star Topology
       ► Ring Topology
        ► Bus Topology
        ► None of the given
 In a ring topology each computer is connected to other thorough a ring
Question No: 3      ( Marks: 1 ) - Please choose one
An ------------method, the network hardware designers specify how type information is included in the frame and the value use to identify various frame types.
       ► Explicit frame type
        ► Ideal frame type
        ► Implicit frame type
        ► None of the given
EXPLICIT FRAME TYPE:
In this type the identifying value is included with frame describes types of
included data.
Question No: 4      ( Marks: 1 ) - Please choose one
An interface for thin Ethernet must have an ____________ connector , and must generate signals according to the_____________ specification.
       ► RJ-45, 10 Base T (reference not available)
        ► RJ-45, 10 Base 5
        ► BNC, 10 Base 2
        ► BNC, 10 Base T
Question No: 5      ( Marks: 1 ) - Please choose one
A Bridge forwards or filters a frame by comparing the information in its address table to the frame’s__________
       ► Layer 2 source address
        ► Source node’s physical address
        ► Layer 2 destination address     (not confirm)
       ► Layer 3 destination address
 Question No: 6      ( Marks: 1 ) - Please choose one
Most WAN systems include a mechanism that can be used to eliminate the common case of duplication routing is called___________
        ► Hierarchal address
        ► Default route
        ► Shortest path
       ► None of the given
Most WAN systems include a mechanism that can be used to eliminate the common case of duplication routing is called Default route. The mechanism allows a single entry in a forwarding table to replace a long list of entries that have the same next hope value
Question No: 7      ( Marks: 1 ) - Please choose one
________ of TCP/IP layering model, corresponds to basic network hardware.
       ► Physical Layer
       ► Network Interface Layer
        ► Internet Layer
      ► Transport Layer
LAYER 1:
Corresponds to basic network hardware layer in OSI
Question No: 8      ( Marks: 1 ) - Please choose one
_______ protocols of TCP/IP layering model specify how to ensure reliable transfer.
       ► Physical Layer
       ► Network Interface Layer
        ► Internet Layer
       ► Transport Layer
 The Internet layer in the TCP/IP reference model is responsible for transferring data between the source and destination computers
Question No: 9      ( Marks: 1 ) - Please choose one
________is called an end-to-end protocol because it provide a connection directly from an application on one computer to an application on a remote computer.
       ► IP
       ► UDP
        ► TCP
        ► None of the given
UDP has the following characteristics.
It is an end-to-end protocol. It provides application-to-application communication.
Question No: 10      ( Marks: 1 ) - Please choose one
____________ uses distance vector approach to define routing
       ► BGP
      ► OSPF
        ► RIP
        ► None of the given
 DISTANCE-VECTOR ROUTING:
• It is very simple to implement.
• Packet switch updates its own routing table first.
• It is used in RIP.
Question No: 11      ( Marks: 1 ) - Please choose one
_______    is ideal in a situation where the group is small and all members are attached to contiguous Local Area Networks.
       ► Flood-and -Prune
        ► Configuration-and -Tunneling
       ► Core-Based Discovery
       ► None of the give006E
FLOOD-AND-PRUNE:
Flood-and-prune is ideal in a situation where the group is small and all members
Are attached to contiguous Local Area Networks.
Question No: 12      ( Marks: 1 ) - Please choose one
Router that decrements TTL to __ sends ICMP time exceeded message, with router’s address as source address
       ► 3
       ► 2
       ► 1
       ► 0
Router that decrements TTL to 0 sends ICMP time exceeded message, with router’s
address as source address
Question No: 13      ( Marks: 1 ) - Please choose one
Protocol addresses are abstractions provided by ___________.
       ► hardware
       ► software
       ► operating system
       ► internet
PROTOCOL ADDRESSES AND PACKET DELIVERY:
Protocol addresses are abstractions provided by software
Question No: 14      ( Marks: 1 ) - Please choose one
Although message exchange can be used to bind addresses, sending a request for each binding is hopelessly inefficient.
       ► True
       ► False
 CASHING ARP RESPONSES:
Although message exchange can be used to bind addresses, sending a request for
each binding is hopelessly inefficient
 Question No: 15      ( Marks: 1 ) - Please choose one
ARP is almost always used to bind a ___-bit IP address to a ___-bit Ethernet address.
       ► 32, 48
       ► 24, 32
       ► 32, 64
       ► 32, 128
 ARP is almost always used to bind a 32-bit IP address to a 48-bit Ethernet address
Question No: 16      ( Marks: 1 ) - Please choose one
In the 1970s large organizations began to acquire multiple networks. Each network in the organization formed island. Employees needed to choose a computer appropriate for each task. So they needed multiple screens, keyboards and computers.
        ► False
        ► True
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In the 1970s large organizations began to acquire multiple networks. Each
network in the organization formed island. Employees needed to choose a
computer appropriate for each task. So they needed multiple screens, keyboards
and computers.
Question No: 17      ( Marks: 1 ) - Please choose one
In which method of Address Resolution Protocol the protocol address is determined by hardware address?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
	
Features
 
	Types of
Resolution

	Use full with any hardware
	T

	Address change affects all hosts
	T

	Protocol address is determined by hardware address
	C


       ► T
       ► D
       ► C
       ► T, C
Question No: 18      ( Marks: 1 ) - Please choose one
 
The general form of an IP datagram is with a header followed by data. The header contains information that controls where and how the datagram is to be sent.
       ► True
       ► False
·    Header contains all information needed to deliver datagram to the destination
computer. It contains:
• Destination address
• Source address
• Identifier
• Other delivery information 
Question No: 19      ( Marks: 1 ) - Please choose one
To save traffic, an EGP does not summerize routing information from the autonomous system before passing it to another autonomous system.
       ► True
       ► False
"It provides routing among autonomous systems (EGP).
Question No: 20      ( Marks: 1 ) - Please choose one
Which of the following is a correct representation of the IPv6?
       ► 105.220.136.100.255.255.255.255.0.0.18.128.140.10.255.255 
       ► 105.220.136.100.255.255.255.256.0.0.18.128.140.10.255.255 
       ► 105.220.136.100.255.255.255.255.0.0.18.128.140.10.255.255.256
       ► 105.220.136.100.255.255.255.255.0.0.18.128.140.10.255
Question No: 1      ( Marks: 1 ) - Please choose one
 The number of connections needed for N computer in direct point to point communication is equal to:
        ► (N2 –N)/2
        ► N(N- 1)
       ► N2
        ► None of the given
For ‘n’ computers connections in direct point to point communication = (n^2 –n)/2.
                           
Question No: 2      ( Marks: 1 ) - Please choose one
When an application--------------- data, it makes a copy of the data available to all other computers on the network.
       ► Broadcasting
        ► Multicasting
        ► Unicasting
        ► None of the given (not sure)
 Question No: 3      ( Marks: 1 ) - Please choose one
Ethernet uses a ------ bit static addressing scheme in which each device is assigned a unique address by the manufacturer.
       ► 64
        ► 48
        ► 32
        ► 8
Ethernet uses a 48-bit static addressing scheme
 Question No: 4      ( Marks: 1 ) - Please choose one
 A system with redundant bridges might have a problem with_______ in the system.
        ► Loop
        ► Filters
        ► Spanning Trees
        ► All given choices
 Reference not available
Question No: 5      ( Marks: 1 ) - Please choose one
The product of delay and throughput measures the _____ of data that can be present on the network.
        ► Area
        ► Volume
        ► Length
        ► None of the given
It is computed as delay time multiplied by effective throughput. It measures amount of data that can be present in the network
Question No: 6      ( Marks: 1 ) - Please choose one
Connectionless service, Message-Oriented protocol, best effort delivery service, arbitrary interaction and operating system independent are the characteristics of _____________
        ► TCP
        ► UDP
        ► IP
        ► None of the given
 UDP has the following characteristics.
• It is an end-to-end protocol. It provides application-to-application communication.
• It provides connectionless service.
• It is a Message-Oriented protocol.
• It uses best-effort delivery service.
• It follows arbitrary interaction.
• It is operating system independent
 Question No: 7      ( Marks: 1 ) - Please choose one
 Connection-oriented service, Point-to-point, Complete reliability, Full-duplex communication, Stream interface, Reliable connection startup and Graceful connection shutdown are the services provided by__________
        ► None of the given
        ► TCP
        ► UDP
        ► IP
SERVICE PROVIDED BY TCP:
Following are the services provided by TCP:
• Connection-oriented service
• Point-to-point
• Complete reliability
• Full-duplex communication
• Stream interface
• Reliable connection startup
• Graceful connection shutdown
Question No: 8      ( Marks: 1 ) - Please choose one
The process of using a routing table to select a next hop for a given datagram is called_________
        ► Encapsulation
        ► Reassembling
        ► Routing or forwarding 
        ► None of the given
Reference not available
 Question No: 9      ( Marks: 1 ) - Please choose one
____________ uses distance vector approach to define routing
        ► BGP
        ► OSPF
        ► RIP
        ► None of the given
DISTANCE-VECTOR ROUTING:
• It is very simple to implement.
• Packet switch updates its own routing table first.
• It is used in RIP.
Question No: 10      ( Marks: 1 ) - Please choose one
A multicast routing scheme in which the protocol software builds a delivery tree from a central point is called__________
       ► Distance Vector Multicast Routing Protocol (DVMRP)
        ► Core Based Trees (CBT)
        ► Protocol Independent Multicast_ Sparse Mode (PIM-SM)
        ► Protocol Independent Multicast _ Dense Mode (PIM-DM)
 CORE BASED TREES (CBT):
A multicast routing scheme in which the protocol software builds a delivery tree
from a central point.
 Question No: 11      ( Marks: 1 ) - Please choose one
 One repeater _______, two repeaters ________ the maximum cable length limitation.
       ► doubles, cancel
        ► doubles, triple
        ► square roots, cude roots
        ► and, triple
 One repeater doubles, two repeaters triple the maximum cable length limitation.
Question No: 12      ( Marks: 1 ) - Please choose one
Whenever it handles a packet, IP software needs to separate the destination address into a _________ and ___________.
        ► postfix, Infix
        ► non of these
        ► Infix, prefix
        ► prefix, suffix
 Whenever it handles a packet, IP software needs to separate the destination address into a prefix and suffix
Question No: 13      ( Marks: 1 ) - Please choose one
 Although message exchange can be used to bind addresses, sending a request for each binding is hopelessly inefficient.
        ► True
        ► False
CASHING ARP RESPONSES:
Although message exchange can be used to bind addresses, sending a request for
each binding is hopelessly inefficient.
Question No: 14      ( Marks: 1 ) - Please choose one
 ARP is almost always used to bind a ___-bit IP address to a ___-bit Ethernet address.
        ► 32, 48
        ► 24, 32
        ► 32, 64
        ► 32, 128
ARP is almost always used to bind a 32-bit IP address
to a 48-bit Ethernet address
 Question No: 15      ( Marks: 1 ) - Please choose one
 End-to-end delivery service is connection oriented.
        ► True
        ► False       
End-to-end delivery service is connection less
Question No: 16      ( Marks: 1 ) - Please choose one
 A single networking technology is best for all needs.
 
       ► True
 
       ► False

There is no single networking technology that is best for all needs
Question No: 17      ( Marks: 1 ) - Please choose one
In the 1970s large organizations began to acquire multiple networks. Each network in the organization formed island. Employees needed to choose a computer appropriate for each task. So they needed multiple screens, keyboards and computers.
       ► False
       ► True
In the 1970s large organizations began to acquire multiple networks. Each network in the organization formed island. Employees needed to choose a computer appropriate for each task. So they needed multiple screens, keyboards and computers.
Question No: 18      ( Marks: 1 ) - Please choose one
Which method of Address Resolution Protocol is useful with any hardware?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
	Features
 
	Types of
Resolution

	Use full with any hardware
	T

	Address change affects all hosts
	T

	Protocol address is determined by hardware address
	C


       ► T
        ► C
        ► D
        ► C, D
 
 
 
Question No: 19      ( Marks: 1 ) - Please choose one
In which method of Address Resolution Protocol the protocol address is determined by hardware address?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
	Features
 
	Types of
Resolution

	Use full with any hardware
	T

	Address change affects all hosts
	T

	Protocol address is determined by hardware address
	C


        ► T
        ► D
        ► C
        ► T, C
 
 
Question No: 20      ( Marks: 1 ) - Please choose one
We use the term _______ to refer to a measure of the path that routing software use when choosing a route.
        ► routing path
        ► routing metric
        ► routing
         switching
 We use the termrouting metric to refer to a measure of the path that routing software use when choosing a route
Question No: 1 ( Marks: 1 ) - Please choose one
In Direct point to point communication adding the Nth computer requires------------ new connections.
► None of the given
► N2
► (N2 –N)/2
disadvantage In Direct point to point communication is that adding a new computer to the network requires N-1 new connections .(P# 23)
Question No: 2 ( Marks: 1 ) - Please choose one
In Point-to-Point topology there are two topologies.
► Tree and Ring
► Star and Ring
► Star and Tree
► None of the given
Question No: 3 ( Marks: 1 ) - Please choose one
In -------------, network occupies the smaller area like a room a floor or a building
► LAN
► WAN 
► MAN
► None of the given
In LAN network occupies the smaller area like a room a floor or a building.(P# 4)
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Question No: 4 ( Marks: 1 ) - Please choose one
Hardware that calculates a CRC uses two simple components.
► AND unit and XOR unit
► Shift register and XOR unit
► Shift register and AND unit
► None of the given
CRC uses just two hardware components:
  
 Shift register
   
 Exclusive OR ( XOR unit ) .(P# 20)
Question No: 5 ( Marks: 1 ) - Please choose one
CRC can detect more errors than a simple checksum.
► true 
► false
Question No: 6 ( Marks: 1 ) - Please choose one
The Gigabit Ethernet hardware operates at a rate of --------
► 10 Mbps
► 100 Mbps
► 1000 Mbps
► None of the given
Gigabit Ethernet that operates at 1 Gbps (1000 Mbps) over fiber optics and twisted pair Ethernet cables.
Question No: 7 ( Marks: 1 ) - Please choose one
Formally named __________ informally known as the twisted pair Ethernet or TP Ethernet.
► 10 Base 2
► 10 Base 5
► 10 Base T
► None of the given
10BASE-T:
This is another standard of wiring scheme. It is commonly called 10Base-T, Twisted Pair or TP Ethernet. (P# 43)
Question No: 8 ( Marks: 1 ) - Please choose one
An interface for thin Ethernet must have an ____________ connector , and must generate signals according to the_____________ specification.
► RJ-45, 10 Base T
► RJ-45, 10 Base 5
► BNC, 10 Base 2
► BNC, 10 Base T
Question No: 9 ( Marks: 1 ) - Please choose one
A system with redundant bridges might have a problem with_______ in the system.
► Loop
► Filters
► Spanning Trees
► All given choices
Question No: 10 ( Marks: 1 ) - Please choose one
________ computes shortest paths in a graph by using weights on edges as a measure of distance.
► Greedy algorithm
► Distance vector algorithm
► Dijksta’s algorithm
► Non of the given
Djikstra’s algorithm can accommodate weights on edges in graph. The shortest
path is then the path with lowest total weight (sum of the weight with all edges). It should
be noted that the shortest path is not necessarily with fewest edges (or hops).
Question No: 11 ( Marks: 1 ) - Please choose one
Basic LAN technologies such as Ethernet, Token Ring, and FDDI use a _____.
► Connectionless service paradigm
► Connection-oriented service paradigm
► Both Connectionless and Connection-oriented service paradigm
► None of the given
Question No: 12 ( Marks: 1 ) - Please choose one
_______ protocols of TCP/IP layering model specify how to ensure reliable transfer.
► Physical Layer
► Network Interface Layer 
► Internet Layer
► Transport Layer
LAYER 4: ensure reliable transfer layer 4 in TCP layering model is transport layer.
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Question No: 13 ( Marks: 1 ) - Please choose one
An Internet Address (IP address) is a unique __________ binary number assigned to a host and used for all communication with host
► 48-bit
► 32-bit
► 24-bit
► None of the given
An Internet address (IP address) is a unique 32-bit binary number assigned to a
host and used for all communication with the host
Question No: 14 ( Marks: 1 ) - Please choose one
The address __________ identifies the physical network to which the computer is attached, while the _______ identifies an individual computer on that network.
► prefix , suffix
► suffix , prefix
► suffix , suffix
► None of the given
                           PREFIX:
It identifies the physical network to which the computers are attached.
                          SUFFIX:
It identifies an individual computer on the network.
Question No: 15 ( Marks: 1 ) - Please choose one
___________ places the boundary between the first and second octets
► Class A
► Class B
► Class C
► Class D
Class A places the boundary between the first and second octets. Class B places the boundary between the second and third octets, and class C places the boundary between the third and fourth octets.
Question No: 16 ( Marks: 1 ) - Please choose one
___________ places the boundary between the third and fourth octets.
► Class A
► Class B
► Class C
► Class D
Class A places the boundary between the first and second octets. Class B places the boundary between the second and third octets, and class C places the boundary between the third and fourth octets.
Question No: 17 ( Marks: 1 ) - Please choose one
________ field of header indicates whether a datagram is a fragment or a complete datagram.
► FLAGS
► FLAGMENT OFFSET
► IDENTIFICATION
► None of the given
FRAGMENTATION:
IP uses fragmentation i.e. datagrams can be split into pieces to fit in network with small MTU. Each fragment is an independent datagram. It includes all header fields. Bit in header indicates that the datagram is a fragment
Question No: 18 ( Marks: 1 ) - Please choose one
______ provides connectionless service.
► TCP
► UDP
► IP
► None of the given
UDP has the following characteristics.
• It is an end-to-end protocol. It provides application-to-application communication.
• It provides connectionless service.
• It is a Message-Oriented protocol.
• It uses best-effort delivery service.
• It follows arbitrary interaction.
• It is operating system independent
Question No: 19 ( Marks: 1 ) - Please choose one
UDP and TCP are both_________ layer protocols
► Physical
► Data link
► Network
► Transport
Question No: 20 ( Marks: 1 ) - Please choose one
Connection-oriented service, Point-to-point, Complete reliability, Full-duplex communication, Stream interface, Reliable connection startup and Graceful connection shutdown are the services provided by__________
► IP
► None of the given
► TCP
► UDP
SERVICE PROVIDED BY TCP:
Following are the services provided by TCP:
• Connection-oriented service
• Point-to-point
• Complete reliability
• Full-duplex communication
• Stream interface
• Reliable connection startup
• Graceful connection shutdown
Question No: 21 ( Marks: 1 ) - Please choose one
_______ protocols of TCP/IP layering model specify how to ensure reliable transfer.
► Physical Layer
►Network Interface Layer 
► Internet Layer
► Transport Layer
LAYER 4: ensure reliable transfer layer 4 in TCP layering model is transport layer
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Question No: 22 ( Marks: 1 ) - Please choose one
________identifies which application program on receiving computer should receive the data
► Logical address
► Source port
► Destination Port
► None of the given
FieldDestinationPort identifies which application program on receiving computer should receive the data. While field source port identifies the application programs that sent the data. (reference from E-books)
Question No: 23 ( Marks: 1 ) - Please choose one
________ identifies the application program that sent the data. 
► DestinationPort
► Source port
► Logical address
► None of the given
FieldDestinationPort identifies which application program on receiving computer should receive the data. While field source port identifies the application programs that sent the data. (reference from E-books)
Question No: 24 ( Marks: 1 ) - Please choose one
The Border Gateway Protocol (BGP) uses_________ for all communication
► UDP
► TCP
► Both UDP and TCP
► None of the given
 BORDER GATEWAY PROTOCOL:
It is most popular Exterior Gateway Protocol in Internet. It has following characteristics:
"It provides routing among autonomous systems (EGP).
"It provides policies to control routes advertised.
"It uses reliable transport (TCP).
Question No: 25 ( Marks: 1 ) - Please choose one
Which of the following protocols allows the sender and receiver to enforce polices.
► RIP
► OSPF
► BGP
► RIP and OSPF
Question No: 26 ( Marks: 1 ) - Please choose one
____________ uses distance vector approach to define routing
► BGP
► OSPF
► RIP
► None of the given
ROUTING INFORMATION PROTOCOL (RIP):
It has the following characteristics:
"It is used for routing within an autonomous system (IGP).
"Hop Count Metric: RIP measures distance in network hops, where each network
between the source and destination counts as a single hop.
"It uses UDP for all message transmissions.
"RIP is used over LAN. Version 1 of RIP uses hardware broadcast and version 2 allows
delivery via multicast.
"It can be used to advertise default route propagation. An organization can use RIP to
install a default route in each router.
"It uses distance vector algorithm.
Question No: 27 ( Marks: 1 ) - Please choose one
ICMP message transport is acted upon by getting ICMP encrypted in IP.
► True
► False
ICMP message transport is acted upon by getting ICMP encapsulated in IP (P# 117)
Question No: 28 ( Marks: 1 ) - Please choose one
Protocol addresses are abstractions provided by ___________. 
► hardware
► software
► operating system
► internet
Protocol addresses are abstractions provided by software
Question No: 29 ( Marks: 1 ) - Please choose one
These packets serve same purpose on ________ as frames on ______
► Intranet, LAN
► Internet, WAN
► Intranet, WAN
► Internet, LAN
VIRTUAL PACKETS:
These packets serve same purpose in Internet as frames on LAN
Question No: 30 ( Marks: 1 ) - Please choose one
Address mask defines how many bits of address are in suffix?
► True
► False
Address mask defines how many bits of address are in prefix. Prefix defines how much of address used to identify network.
Question No: 31 ( Marks: 1 ) - Please choose one
A single networking technology is best for all needs.
► True
► False
There is no single networking technology that is best for all needs
Question No: 32 ( Marks: 1 ) - Please choose one
A computer attached to a given network can only communicate with other computers attached to the same network. Is this a problem with multiple networks?

► True
► False
The chief problems with multiple networks are as follows:
• A computer attached to a given network can only communicate with other
computers attached to the same network.
Question No: 33 ( Marks: 1 ) - Please choose one
The term self-identifying is used for Classful IP addresses because the class of the address can be computed from the address__________. 
► itself
► prefix
► suffix
► mask
Classful IP addresses are self-identifying because the class of the address can be computed from the address itself
Question No: 34 ( Marks: 1 ) - Please choose one
Find the class of the address.
10100111 11011011 10001011 01101111
► A
► B
► E
► C
Reference table handouts P # 87
Question No: 35 ( Marks: 1 ) - Please choose one
Find the class of the address:
11110011 10011011 11111011 00001111 
► A
► C
► E
► B
Reference table handouts P # 87
Question No: 36 ( Marks: 1 ) - Please choose one
In which method of Address Resolution Protocol the protocol address is determined by hardware address?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
► T
► D
► C
► T, C
 Reference table handouts P # 97
Question No: 37 ( Marks: 1 ) - Please choose one
Which method of Address Resolution Protocol requires hardware broadcast?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
► D
► T
► C
► T, D
Reference table handouts P # 97
 HYPERLINK "http://groups.google.com/group/vuZs" 
Question No: 38 ( Marks: 1 ) - Please choose one
Which method of Address Resolution Protocol resolution with minimum delay?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
► T, D
► c
► T
► T, C
Reference table handouts P # 97
Question No: 39 ( Marks: 1 ) - Please choose one
In which method of Address Resolution Protocol the implimentation is more difficult?
Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
► T, C
► T
► C
► D
Reference table handouts P # 97
Question No: 40 ( Marks: 1 ) - Please choose one
On of the design goals for unicast route propagation is __________.
► Consistency
► inconsistency
► stability
► dynamic addressing
On of the design goals for unicast route propagation is stability—continual changes in route are undesirable because they lead to higher jitter and datagram arriving out of order. Thus, once a unicast routing protocol finds a shortest path, it usually retains the route until a failure makes the path unusable. (Reference from E-book)
Question No: 41 ( Marks: 1 ) - Please choose one
Propagation multicast routing information differs dramatically from unicast route propagation?
► True
► False
Propagating multicast routing information differs dramatically from unicast route propagation. The difference arises because internet multicast allows dynamic group membership and autonomous senders
Question No: 42 ( Marks: 1 ) - Please choose one
The IP multicast abstraction allows an application running on an arbitrary computer to leave a multicast group at any time. While _____________ application on a computer remain a member of a group.
► One or more
► only one
► no
► many
Question No: 43 ( Marks: 1 ) - Please choose one
To save traffic, an EGP does not summerize routing information from the autonomous system before passing it to another autonomous system.
► True
► False
To save traffic, an EGP summerize routing information from the autonomous system before passing it to another autonomous system. More important an EGP implements policy constraints that allow a system manager to determine exactly what information is released outside the organization. (Reference from E-book)
Question No: 44 ( Marks: 1 ) - Please choose one
In IPv6 the type of address used for collection of computers with same prefix. Are known as_________.
► Anycast
► Unicast
► Multicast
► Non of the given
Following are special types of addresses, IPv6 uses:
Unicast: It is used for single destination computer.
Multicast: It is used for multiple destinations; possibly not at same site.
Cluster: This type of address is used for collection of computers with same prefix,
datagram is delivered to one out of cluster.
Question No: 45 ( Marks: 1 ) - Please choose one
Special types of addresses in IPv6 used for multiple destinations; possibly not at same site. Are known as_________.
► Unicast
► Anycast
► Multicast
► Non of the given
Following are special types of addresses, IPv6 uses:
Unicast: It is used for single destination computer.
Multicast: It is used for multiple destinations; possibly not at same site.
Cluster: This type of address is used for collection of computers with same prefix,
datagram is delivered to one out of cluster.
Question No: 46 ( Marks: 1 ) - Please choose one
UDP offers application programs a Message-Oriented Interface, applications can depend on protocol to preserve data boundaries.
► True
► False
UDP offers application programs a Message-Oriented Interface. It does not divide messages into packets for transmission and does not combine messages for delivery.
ADVANTAGES:
• Applications can depend on protocol to preserve data boundaries.
Question No: 47 ( Marks: 1 ) - Please choose one
Reliability is the responsibility of the _________ layer
► Network
► Datalink
► Transport
► Application
Reliability is the responsibility of the Transport layer
Question No: 48 ( Marks: 1 ) - Please choose one
TCP uses _______ mechanism to control the flow of data.
► door
► window
► acknowledgment
► retransmission
TCP uses window mechanism to control the flow of data.
Question No: 49 ( Marks: 1 ) - Please choose one
The time for acknowledgement to arrival of packet depends on.
► Distance to destination and Current traffic conditions
► Current traffic conditions
► Distance to destination
► non of these
The time for acknowledgement to arrive depends on:
• Distance to destination
• Current traffic conditions
Question No: 50 ( Marks: 1 ) - Please choose one
FDDI can transmits data at a rate of ----------
► 100 million bits per second
► 10 million bits per second
► 1000 million bits per second
► None of the given
FDDI: Fiber distributed data interconnect (FDDI) is another ring technology. Its most
important features are:
It uses fiber optics between stations and transmits data at 100Mbps.
Questio1) When an application--------------- data, it makes a copy of the data available to all other computers on the network.

       ► Broadcasting
        ► Multicasting

        ► Unicasting

       ► None of the given

2) Ethernet uses a ------ bit static addressing scheme in which each device is assigned a unique address by the manufacturer. 

       ► 64

        ► 48
        ► 32

        ► 8

3) The product of delay and throughput measures the _____ of data that can be present on the network.

      ► Area

        ► Volume (supposition)

        ► Length

        ► None of the given

  4) Connectionless service, Message-Oriented protocol, best effort delivery service, arbitrary interaction and operating system independent are the characteristics of _____________

        ► TCP

        ► UDP
        ► IP

        ► None of the given

  5) ____________ uses distance vector approach to define routing

        ► BGP

        ► OSPF

        ► RIP
        ► None of the given

6) Whenever it handles a packet, IP software needs to separate the destination address into a _________ and ___________.

        ► postfix, Infix

        ► non of these

        ► Infix, prefix

        ► prefix, suffix
7) ARP is almost always used to bind a ___-bit IP address to a ___-bit Ethernet address.

       ► 32, 48
        ► 24, 32

        ► 32, 64

        ► 32, 128

8) Which method of Address Resolution Protocol is useful with any hardware?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
       ► T

        ► C (Supposition)

        ► D

        ► C, D

9) In which method of Address Resolution Protocol the protocol address is determined by hardware address?

Were "T" stands for Table lookup, "C" for Closed-form Computation and "D" for Data Exchange?
       ► T

        ► D

        ► C
        ► T, C

10 )We use the term _______ to refer to a measure of the path that routing software use when choosing a route.

        ► routing path

        ► routing metric
        ► routing

        ► switching

11) A network uses a ------arranges for computers to be connected in a closed loop.

        ► Star Topology

       ► Ring Topology
       ► Bus Topology

       ► None of the given

12) An interface for thin  Ethernet must have an ____________  connector , and must generate signals according to the_____________ specification. 

       ► RJ-45, 10 Base T
        ► RJ-45, 10 Base 5

        ► BNC, 10 Base 2

       ► BNC, 10 Base T

13) _______ protocols of TCP/IP layering model specify how to ensure reliable transfer.

       ► Physical Layer

      ► Network Interface Layer 

       ► Internet Layer

       ► Transport Layer
14)____________ uses distance vector approach to define routing

        ► BGP

       ► OSPF

       ► RIP
       ► None of the given
n No: 51 ( Marks: 2 )
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